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Abstract

Estimating biomechanical measures of the human body requires body segment inertial
parameters (BSIP). Widely cited estimation methods (Chandler et al., 1975; Dempster, 1955) are
based on an elderly population, have inherent errors (Hanavan, 1964) and may not represent
subjects to which they are applied. Subject specific methods such as medical imaging or
geometrical techniques can be time consuming, expensive and may require a variety of manually
acquired inputs. Presented here is an alternative, subject specific approach to estimating BSIPs,

requiring no manual measurements at a equipment cost of approximately $300.

A 3D scanning protocol using a single Microsoft Kinect V2 was developed. Twenty-one subjects
(10 male, 11 female) were scanned 3 times with per scan durations of approximately 20-30
seconds. Each full body 3D scan was segmented in Meshlab according to a 16 segment link
model defined by Zatsiorsky and Seluyanov (1983). The 3D data was analyzed in custom
MATLAB software that estimated the volume, MOI, COM, length and mass of each of the link
segments. Results were compared to estimates obtained using an elliptical cylinder model (ECM)
(Jensen 1978) and to estimates obtained using regression equations developed from medical

imaging techniques (Zatsiorsky and Seluyanov 1983).

The body volume estimates using the Kinect demonstrated high repeatability (ICC>0.95) with a
volume overestimation ranging from 0.0023 m’ (3%) for males and 0.0038m” (5.1%) for females.
The upper torso accounted for the majority of the overestimation of approximately 0.0019m’
(83%) for males and 0.002 m’ (53%) for the females. The Kinect protocol estimated COM with
an average error of <2%. Segmental mass estimates were overestimated by 3.11% for males and
5.23% for females when compared to ECM. This research established that the Kinect V2 could
be used as a tool for BSIP estimation. Future work should improve on the scanning posture,
scanning protocol and reducing the scan duration. Furthermore, future research should

investigate on methods to eliminate the manual segmentation proposed for this protocol.
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Chapter 1

Introduction

1.0 The Human Body

Differences in the environments we are exposed to, personal habits and genetics (to name a few)
come to differentiate our bodies internally and externally. Consequently, it is of no surprise that
human body proportions vary among people (Jensen, 1993). The diversity of human bodies
makes modeling the body challenging. In biomechanics, there is a need to understand and model
morphological differences amongst humans to further develop an understanding of how the body

interacts with the environment around it (Damavandi et al., 2009; Wall-Scheffler, 2012).

Interest in the human body and understanding the underlying mechanics dates back as early as
1679 with work done by Borelli (Pope 2005, Clauser et al.,1969). Borelli designed experiments
to determine the COM of a grown man amongst many other investigations. He showed an
understanding of load distribution on the spine and of the mechanics of the musculoskeletal
system (Pope 2005, Clauser et al.,1969). Our comprehension of the human body has grown

greatly since Borelli’s pioneering work and knowledge continues to grow with advancements in



our technology. As our understanding expands, representative models that describe a body in

motion can be developed with far greater accuracy and detail than possible before.

The underlying mechanical characteristics of motion are estimated using inverse or forward
dynamics. For a human body in motion we can monitor the kinematics, therefore inverse
dynamics can be applied. Inverse dynamics is a process of calculating forces and moments using
representative kinematic information. Examples of calculating inverse dynamics are the Newton-

Euler equations, which use the kinematic and inertial inputs to solve for forces (Equations 1-2).

F, =may F, =ma, F, =ma,

y y

Equation 1: Force components (Fy, Fy, F,); mass (m); linear acceleration components (ax ay, a,)
in coordinate system (CS) x-y-z.

Mx = Ixx'Qxx + (Izz - Iyy)ﬂyyﬂzz

My = Inyyy + (Ixx - Izz)-sz'Qxx

MZ = IZZQZZ + (Iyy - Ixx)'Q'xx'ny

Equation 2: Components of the sum of external moments (M,, M,,, M,); principal moments of
inertia (Iyy, Iy, I,;); angular velocity () and angular acceleration (Q) in CS x-y-z

The specific input parameters of interest are the body segment inertial parameters (BSIPs) and
are the topic of this dissertation. BSIPs describe the inertial properties of a body in motion and of
the segments (links) of the human body. BSIPs are affected by the morphological variations
amongst human bodies and can be difficult to estimate (Jensen 1993). Developing an acquisition

method for estimating BSIPs is the foundation and rationale of this project.



1.1Body Segment Inertial Parameters

Biomechanics has provided insight to how the body functions and responds to movement in its
environment (Pearsall & Reid, 1994). The development of models, supported by biomechanical
research, has allowed for the understanding of how various body components such as muscles,
tendons, ligaments and bones interact. However, accuracy in modeling the body depends on how
well mechanical approximations estimate true anatomical structures (Williams et al., 2009).
Amongst biomechanical input parameters, BSIPs have been shown to affect the accuracy of
biomechanical estimations, especially in high velocity situations such as running or jumping
(Ganley & Powers, 2004; Pearsall & Costigan, 1999) . Small percentage variations in BSIPs
estimates can result in discrepancies in the joint resultants obtained from inverse dynamics

(Andrews & Mish, 1996).

In modeling, the human body can be treated as a rigid multi-linked system composed of segment
limbs each having different geometric and inertial parameters (Jensen 1993). Some of the
differences between link segments can be accounted for by morphological variables otherwise
known as BSIP’s, which include: the body link segment mass, cartesian locations of the COM
and the moments of inertia. Attention has been given to the process of attaining these parameters
since the late 1800’s, yet full documentation of BSIP variations amongst humans is ongoing and
incomplete (Jensen 1993; Pearsall & Reid, 1994). Acquiring more specific data to better model

the various populations is required.

BSIPs are mechanical parameters; they are influenced by the physical geometric shape and
internal composition of the body. As we age and grow, our limbs change and as a result BSIPs

have been shown to differ between age, gender and racial groupings (Cheng et al., 2000; Jensen



& Fletcher, 1994; Reid & Jensen, 1990). Therefore, BSIP estimates must be used with great
caution. Various investigators have warned against arbitrary use of BSIP models (Chandler et al.,
1975; Clauser et al., 1969; Pearsall et al., 1994). In fact, it is important to know the specific
population a model, which estimates BSIPs, is based on too appropriately use it to approximate

the inertial parameters of a specific subject.

The methods that have been developed to estimate BSIPs range in cost, time requirement and
accuracy. BSIP acquisition methods have many similarities yet attain estimations of inertial
parameters in distinct ways, with each method having underlying advantages and disadvantages.
Examples of methods are: cadaveric, medical imaging (MRI, CT, and X-ray, DEXA),
mathematical (geometric), surface scanning (photography, videography, infrared, laser, computer

vision) and other methods (water submersion, balance board, and quick release).

Direct methods, which used cadavers, create the foundation for this field of work (Chandler et
al., 1975; Clauser et al., 1969; Dempster, 1955). Medical dissections allow for body link
segments to be segmented, measured and analyzed in vitro, without restriction (Dempster, 1955).
Researchers have studied body tissue and determined segment density properties using cadaveric
methods, yet parameters such as the distribution of tissue density across the various body
segments are difficult with this technique. With advancements in technology, estimating segment
density and tissue distribution has been made possible with the use of Computed Tomography
(CT), Magnetic Resonance Imaging (MRI) and Dual-energy X-ray Absorptiometry DEXA (or
DXA) to name a few (Bauer et al., 2007; Durkin 2003; Lee et al., 2009; Pearsall et al., 1996;
Rossi & Lyttle, 2013). Although expensive and not universally available, medical imaging
technology has contributed to the understanding and knowledge of estimating BSIPs. Body

segments such as the thigh and trunk have been explored in detail using this technology. The

4



diverse tissue distribution and complex internal structures of these body segments make it
difficult to compute BSIPs using methods such as cadaveric dissections (Durkin et al., 2005;

Pearsall et al., 1996).

Geometrical modeling has focused on constructing the morphological properties of the segments
using mathematical shapes. Modeling the body as a series of shapes gives us the opportunity to
determine BSIPs non-invasively and inexpensively on living subjects. The inputs for geometrical
models range to account for the different shapes of each of the body segments (examples:
Hanavan 1964; Hatze and Baca 1992; Jensen 1978; Whitsett 1963; Yeadon and Morlock 1989).
Mathematical inputs, termed anthropometric measurements, represent measurement information
regarding the size of body segments. As with any model, the accuracy will be limited by the
physical expressions of the input parameters, in this case, the anthropometric measurements. As
anthropometric measurements are commonly estimated manually, there is a certain degree of
inaccuracy associated with any hand measurement. With the development of technology, manual

measurements are becoming outdated, as will be further discussed.

Surface imaging methods include the use of stereo photography, videography and 3D scanning to
name a few. This approach intends to reduce error from manual 2measurements, which are used
in estimating BSIPs by eliminating the manual nature of estimating the measurements. Surface
imaging methods aim to attain volumetric information directly from a subject with the use of a
camera. By applying known density values to these volumetric profiles approximations for a
wide range of BSIPs are possible (examples : Clarkson et al. 2012; Gittoes et al, 2008; Lu and
Wang 2008; Mcconville and Churchill 1980; Peyer et al., 2015; Wicke and Lopers 2003; Young
et al, 1983). Other surface scanning techniques include the use of infrared and laser scanning,

where a high degree of accuracy has been shown (Ma et al., 2011; Norton et al., 2002).



1.2 Motivation of Project

Estimating inertial properties of the human body is essential to solving many biomechanical
equations. As BSIP estimations have shown to be sensitive to the chosen model, great caution
has to be taken when choosing generalized input BSIPs. With subject specific modeling
requiring manual measurements and time consuming experimental setups there is a need to
explore an accelerated and inexpensive method of acquiring BSIPs directly from persons of

interest with simplicity and reliability.

The Microsoft Kinect Version 1 (V1) (Microsoft Corporation, Redmond, USA) camera has
shown to provide potential in this field of work and could provide a means of acquiring subject
specific morphological information of the full body (Clarkson et al. 2012, Clarkson et al. 2014) .
With the recent release of the Microsoft Kinect Version 2 (V2) (Microsoft Corporation,
Redmond, USA), the ability to acquire 3D data at a higher accuracy than before has been made
possible (Lachat et al., 2015). However, this has not yet been explored in detail in relation to
BSIPs measurements of living human beings. Investigating the capabilities of this device as a
measuring tool to acquire subject specific BSIP estimation will provide valuable insights on the

technology and how it can be applied to 3D modeling of living humans.

The specific motivation of this study is to use the Microsoft Kinect V2 to determine subject
specific BSIPs of living subjects and evaluate if there is potential for this device in this context.
An understanding of calculating BSIPs is crucial before adopting the device for these purposes.
Once a thorough understanding of estimating BSIPs is obtained, evaluation of using the Kinect
to calculate BSIPs will be investigated. Establishing the feasibility of using the device and

determining reliability is imperative to adopting the device into a biomechanics laboratory and



will provide valuable insight on how using this technology compares with other BSIP estimation

techniques.

1.3 Objectives

The objectives of this dissertation are as follows:

1)

2)

3)

To determine the feasibility of using a Microsoft Kinect V2 in estimating BSIPs of living
subjects. This will require developing an experimentation protocol to test the use of the
Kinect V2 camera in the context of estimating BSIPs. Specifically, it is of interest to
estimate: volumetric parameters, mass, cartesian location of COM, moment of inertia
tensors and longitudinal segment lengths using the Kinect V2.

To compare the BSIPs estimated using the developed protocol to those acquired using a
subject specific method, which has been evaluated in the literature.

To compare the estimates to BSIPs estimated using a generalized model of a similar

population.



1.4 Dissertation Outline

This Dissertation consists of 6 Chapters including the Introduction. Chapter Two: Literature
Review is a review of the related literature detailing the various methods that have been
developed to estimate BSIPs, the biomechanical relevance of BSIPs, as well as a background on
body segment densities, segmentation and the Microsoft Kinect. Chapter Two gives the reader a
better understanding of the importance of this field of work and background on the relevant
literature. Chapter Three: Methods describes the experimental approach. An overview of the
software and the application of various code written for the data collection and analysis are also
presented in this chapter. Chapter Four: Results presents the findings and explanation of the
collected data. Subsequently Chapter Five: Discussion provides a detailed analysis of the results
and examines the comparisons of the data to other BSIP estimation methods presented in the
literature. Chapter Six: Conclusions and Future Recommendations concludes on the findings and

discusses recommendations for future work in this field are also presented.



Chapter 2
Literature Review

2.0 Introduction

To relate forces to motion requires the input of inertial properties. In dynamic analysis, inertial
properties must be computed for kinetic investigation. When the human form is considered, these
properties are commonly referred to as the body segment inertial parameters (BSIPs). Treating
the human body as a multi-link system allows for each body segment (link) to be described with
its own specific geometric and inertial parameters (Jensen 1993). These parameters include:
body segment mass, moments of inertia (MOI) and cartesian locations of the centre of mass

(COM).

2.1 BSIP Relevance

Investigation of inertial parameters of the human body and its extremities is an important part of
the study of human motion (Nikolova 2010). Researchers studying the kinetics of motion

9



require BSIP inputs. Clinically, this may be used in identifying patterns in gait, which could help
indicate distress in the joints. It can be used to inquire on sporting performance or help identify
regions of high stress in joints post-trauma (as examples). There is some debate with the clinical
significance of errors in BSIPs. Some researchers show inconsequential importance in BSIP
uncertainties (Challis and Kerwin, 1996; Pearsall and Costigan, 1999; Reinbolt et al., 2007)
while other researchers state that misestimating these measures can produce significant
variations in the observed joint kinetics (Andrews and Mish, 1996; Kingma et al., 1996; Kwon
2001; Pataky et al., 2003; Silva and Ambrésio, 2004). However, the aforementioned studies
compare different inertial parameters and in different sections of the body, making it difficult to

make any generalizations.

In one example, Pearsall and Costigan (1999) used predictive BSIP models and incrementally
altered the output BSIPs up to +/- 40%. The results showed that accuracy in BSIP estimation
should be of concern when looking at open chain or high acceleration activities, such as running,
but not as large of a concern when looking at low speed activities such as walking. Pearsall and
Costigan also observed that fluctuating segment mass estimations, especially at the thigh,
resulted in a significant change in estimated reaction forces (Pearsall and Costigan 1999). Rao et
al. (2006) showed that BSIP estimates are sensitive to the predictive model that is used to
estimate the parameters, with BSIP estimations (from various modeling techniques) ranging from
9.73-60% in estimation differences. This corresponds to results showing maximum differences
of 20.1% in the peak extension/flexion moment of the hip, suggesting that the influence of BSIPs
cannot be neglected and models must be carefully chosen (Rao et al., 2006). The work from
Andrews and Mish (1996) concluded that small percentage variation in BSIPs could propagate in

to larger variations in the joint resultant forces obtained from inverse dynamics. When high
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accuracy is a concern in calculated joint resultants, then considerable care needs to be taken

when choosing BSIP estimation methods (Andrews and Mish, 1996).

In other studies, the determination of resultant joint moments has shown to be sensitive to the
estimation of the COM of the body segments (Challis & Kerwin, 1996). Segmental mass values
have also been shown to influence the calculation of joint torques (Pataky et al., 2003; Pearsall,
D. & Costigan, 1999). Kwon (2001, 1996) showed that the specific method of BSIP estimation
significantly affected the simulation accuracy in airborne movement (high acceleration). This left
Kwon to conclude that the more individualized BSIP estimation methods generally provided
more accurate simulation results (Kwon 2001, 1996). However, Lee et al. (2009) found that their

highly sophisticated BSIP estimation method which used MRI for geometrical data and DEXA

for mass distribution only resulted in differences of less than 0.091(—;;1 in the hip joint moment

during gait when compared against the results obtained using four simpler models from
literature. The study suggested that the joint kinetic computations during gait are relatively

insensitive to BSIP variations amongst methods (due to the low accelerations) (Lee et al., 2009).

Subject morphology plays a role in BSIP estimation especially when choosing a representative
model. Damavandi et al. (2009) showed that on average very lean subjects (low BMI) showed
MOI estimates 13.2% lower than those of average BMI. The high BMI subjects showed to be on
average 17.9% higher in the MOI estimates (Damavandi et al., 2009). This only confirms the
need to use subject specific estimations. There is little dispute that obtaining BSIPs, which are
more representative, will provide more accurate predictive kinematic and kinetic analyses of
human motion. The clinical significance of the variations and errors resulting from BSIP

estimation is a subject of debate. However, influence of estimations errors is existent and should

11



not be overlooked in movements that generate higher accelerations than regular gait (Lee et al.,

2009) and for subjects which are not well represented in the literature (Damavandi et al., 2009).

2.2 Body Segmentation

The segmentation of the body into specific segments is an important aspect of BSIP estimation.
Segmentation definitions differ amongst estimation methods (examples: (Chandler et al., 1975;
Dempster, 1955; Hanavan, 1964; Hatze 1980; Jensen 1978; Paolo de Leva, 1996; Yeadon &
Morlock, 1989; Zatsiorsky & Seluyanov, 1983)). The trunk region is once example were the
segmentation differs between authors (examples: (Erdmann 1997; Pearsall et al., 1994, 1996)).
Therefore, it is important to be aware of how researchers have chosen to segment the body in
their method in order to properly gather input parameters and understand the full meaning of the
estimated BSIPs from a model. At this time there does not exist any segmentation standard,
making it difficult to compare between differing segmentation protocols published in literature

(Zatsiorsky 2002). An example of three different trunk segmentations is shown in Figure 1.

Upper Trunk Upper Trunk

Middle Trunk

Lower Trunk Lower Trunk

A B

Figure 1: Differing segmentation protocol of the trunk. A. Dempster’s (1955) two-segment trunk
B. Zatsiorsky et al. (2002) three-segment trunk C. Erdmann (1997) ten segment trunk. Images A-
B taken from (Pearsall et al., 1996)
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2.3 Segment Density

Body segment density may be required to estimate BSIPs. Depending on the method used, (as

will be described below in 2.4 BSIP Estimation Methods) the segment density is either directly

estimated or a published value is used in conjunction with estimated volumetric parameters to

acquire BSIP parameters. A range of body segment densities is shown in Table 1 below.

Table 1: Body segment density parameters from a variety of acquisition techniques

Technique Medical Cadavers CT/MRI DXA
used
(Harless, (Dempster (Clauser et (Chandler et  (Pearsall, (Pearsall, (Erdmann, (Wicke
1860)’ ,1955)  al,1969)  al., 1975) etal, etal., 1997) &
Reference 1994) 1996) Dumas,
2014)
Total - 1.042+0.018
Body - - - -
Head 1.11£0.120 1.071 1.05640.020 . . . ]
Full 1.023+0.032°
Trunk 10320065 ’ 0.853£0.039"  0.94£0.02 0.960 1030 -
Upper
Trunk - - - 0.82:0.04 0.870 0.908 -
Abdomen - - ; 1.01£0.01 1.020 1.043 -
Pelvis - - - 1.02+0.01 1.070 1.077 ;
Thigh R:1.069+0.013  1.05£0.008  1.045+0.017  R:1.018+0.012 ] ] ] F:1.008
L:1.068+0.014 L:1.021+0.012 M:1.051
R:1.059+0.007
Shank R:1.09940.019  1.09£0.015  1.085£0.014 |\ '071,0'021 i ] ] F:1.023
L:1.101+0.021 o : M1.074
R:1.073%0.024
Foot R:1.089+0.600 1.10+0.056 1.085+0.014 L:1.069+0.024 _ - - -
L:1.089+0.010 o '
UPPEr  pi108740.030 10740027  1058£0.025 R:0.997:0.012 ] ] ] F:1.055
Arm L:1.090+0.003 L:1.012+0.015 M:1.071
Forearm  R:1.106£0.004  1.13+0.037  1.099+0.018  R:1.043+0.018 . i . F:1.067
L:1.112+0.040 L:1.061+0.017 M:1.086
Hand R:1.114£0.004  1.16£0.110  1.108+0.019  R:1.079£0.017

L:1.111+0.007

L:1.081+0.011

_ !'The source is reported from [(Bjgrnstrup, 1996)]
* Head +Neck **Trunk+Head+Neck
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2.4 BSIP Estimation Methods

Early techniques were effective methods of estimating BSIP parameters. For example, the
immersion of limbs into water is a process where the measurement of water a segment or full
body displaces is related to its volume. Early work using this method was done by Harless
(1960) but to this day work appears (Norton et al., 2002; Wicke & Lopers, 2003; Zatsiorsky
2002) using this as a gold standard for volume estimation (Harless (1960) taken from : Drillis et
al., 1964)). Techniques such as suspending body segments (either of human cadavers or dental
cast models) about an endpoint and allowing them to oscillate allowed for the MOI to be
estimated from the period oscillation (Drillis et al., 1964; Hatze., 1975). Other methods, such as
the quick release method, measured the deflection and force of a spring. This information was
used to determine accelerations of the limb and then to estimate the MOI. In another method, the
reaction board method, a board supported at 2 points (one of which is a force scale) is used to
determine COM positions (based on static equilibrium) (Drillis et al., 1964). With advancements
in technology, these methods are less used now but provide a foundation in developing

techniques for estimating human BSIPs. Figure 2 illustrates the aforementioned methods.
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Figure 2: A. Water submersion of the arm to determine volume B. Reaction Board used to
determine COM based on static equilibrium C. Oscillating a cast of an arm to determine MOI D.
Quick release method of the subjects forearm used to determine MOI. (Images adapted and
modified from Drillis et al., 1964)

2.4.1 Medical Cadavers

The dissection of the human body dates back to as early as the third century B.C where Greeks
became some of the first scientists to perform systematic dissections of humans (Staden, 1992).
Since then, dissection has provided and continues to provide very valuable medical insight on

revealing anatomical details of the human body (Ogeng, 2014).

The study of cadavers for deriving biomechanical qualities such as BSIPs has been crucial for
developing understanding and creating a foundation in this field of research. Work done by

Dempster (1955) has been regarded as one of most extensively detailed in biomechanical
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research of medical cadavers (Reid & Jensen, 1990). Dempster performed an intensive cadaver
dissection of 8 elderly men with which he created tables showing body segment parameters as
proportions of body height and mass. The cadavers, all Caucasian men, were reported to be
smaller than the average males (Dempster, 1955). Dempster used various techniques to calculate

various BSIPs as shown in Figure 3.

Figure 3: Various procedures associated with calculating BSIPs of disassembled cadaver. A. The
trunk suspended upon a knife-edge to calculate MOI B. Lower limb suspended on knife-edge to
calculate MOI C. Limb on scale to determine mass then submerged into water to determine
volume. (Images adapted from: (Dempster, 1955)).

There were earlier studies done on medical cadavers, such as those presented by Braune et al.
(1889) but Dempster’s work was far more detailed and had a significantly larger subject pool.
Shortly after, Barter (1957) put together data from Dempster along with data from studies by
Braune et al. (1889) and established regression equations for predicting segment masses based on
the body mass of the subject (Barter, 1957) . These regression equations have been reported as a
fast and easy means of estimating segment mass, despite the many limitations and error

associated with them (Clauser et al., 1969).
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Clauser et al. (1969) and Chandler et al. (1975) presented tables similar to those of Dempster
based on their own cadaveric experiments (Chandler et al., 1975; Clauser et al., 1969). As with
Dempster (1955), their studies had small samples sizes (10 specimens from Clauser et al. (1969)
and Chandler et al. (1975) dissected 6 specimens) and were based again on older Caucasian male
populations. Both Chandler et al. and Clauser et al. used palpable anatomical landmarks to
identify the ends of segments in contrast to the subjective determination of joint centers done by
Dempster (1955). The studies by Dempster (1955), Clauser et al. (1969) and Chandler et al.
(1975) represent some of the most comprehensive data based on direct measurement (Pearsall &
Reid, 1994). However, extrapolating those data to represent other populations can be non
representative due to different body morphologies and small cadaveric samples they are derived
from (Rossi & Lyttle, 2013). Pooling data is also difficult because of differences in the
segmentation patterns observed between the studies (Durkin 2003). This makes it problematic to
use these equations as an accurate means of estimating subject specific BSIPs. Table 2 shows
example differences seen between varying selected methods for estimating the mass of the thigh,

forearm and foot.

Table 2: Example of three body segment mass equations from various sample literature based on
elderly male cadaveric data W=Total Body Mass

\ Segment (Dempster, 1955) (Barter, 1957) (Chandler et al., 1975)
Thigh Wikg] x 0.10 W(lbs] x 0.090 + 1.60 Wikg] x 0.1027
Forearm Wilkg] x0.016 W/lbs] x0.020 - 0.25 Wilkg] x 0.0161
Foot Wilkg] x0.0145 W(lbs] x0.010 +0.75 Wikg] x 0.0147

The use of medical cadavers has provided an important foundation in BSIP estimation. Directly
measuring BSIP straight from the body is highly advantageous but comes with a variety of

limitations and concerns. Cadaveric studies have been questioned for their validity in
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representing BSIP measurements of living subjects. Fluid loss during segmentation, properties of
deceased tissues and the age and state of the cadavers are some of the concerns from these types
of studies (Durkin 2008; Lephart et al., 2014; Pearsall & Reid, 1994). In one example, Lephart et
al. (2014) showed that significant differences do exist in tissue that has been thawed compared to
frozen tissue. Lephart et al. also showed that body somatotypes show significant differences in
tissue density and should be considered when choosing a BSIP estimation method (Lephart et al.,
2014). There is difficulty in obtaining a representative pool of cadavers varying in age, gender,
BMI and ethnicity and it is a major limitation with this method in acquiring representative BSIPs
for a large range of people. Other limitations that exist can be cost, intricacy and ethical
considerations amongst a few. This has led to the development of other techniques to estimate

BSIP parameters. A summary of representative cadaveric literature is shown in Table 3.
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Table 3: Summary of a variety of cadaver studies from literature used to estimate BSIPs. (Volume (V), Mass (M), Density (D),
Race(R), Caucasian(C)) This doesn’t not reflect the extent of full literature

Subject Pool information Parameter
Reference # Sex Age R BMI V M COM MOI D Comments
1955 (Dempster, 1955) 8 M 52-83 X X < Water displaceme_nt to determine volume of
the limbs. Caucasian elderly men
1969 (Clauseretal,1969) 13 M 2478 _ X X X
(Chandler et al.,
1975 1975) 6 M 4565 C X X X
(Liu & Wickstrom,
1972 1972) 7 M - C X X - Only Trunk
Comparison of frozen to thawed tissue and
Lephart et al., 2014 2 M 87-94 .
2014 (Lephartetal,, 2014) * * ®  the effect on BSIPs
(Clarys & Marfell- IM (1182 Illleasuremepts taken .off cac}ilgVErs to
1986 Jones, 1986) 6 3F 15-79 - - - evelop regression equations which estimate

mass
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2.4.3 Medical Imaging

With the growing availability of medical imaging technology, the use of these techniques for
directly measuring BSIPs on living humans has been shown (Durkin 2008). Attaining tissue
density and mass distribution information from living subjects, which is possible with imaging
methods, has been shown to overcome some of the limitations associated with cadaveric
dissection, with the potential to providing more accurate measures. Medical imaging
technologies that have been used in this field are: Computer Topography (CT), Magnetic
Resonance Imagining (MRI), Dual Energy X-ray Absorptiometry (DEXA) and Gamma scanning

to name a few.

CT has been used as a technique for BSIP estimation on living subjects (examples: (Erdmann,
1997; Huang & Suarez, 1983; Pearsall et al., 1996)). From CT scanning of biological tissue,
density values can be obtained on a pixel-by-pixel basis allowing for precise determination of
tissue density along the length of the body. Applying the values to volumetric estimates can
provide estimates of segment mass distribution and better approximate the overall density of
each of the body segments (Durkin 2008). Huang et al. (1983) described CT as an excellent
approach and commented that methods have been developed to compute mass density and inertia
tensors of cross sections from CT images, making CT low dosage in vivo approach for

estimating subject specific BSIPs (Huang & Suarez, 1983).

In an experiment done by Erdmann (1997), 15 male subjects had their trunk segment scanned
which lead to the development of predictive equations to estimate the centers of mass of the
trunk. Pearsall et al. (1996) also performed CT of the trunk but of 2 males and 2 female subjects.

Pearsall et al. determined mass distribution and BSIP information of the trunk along slices taken
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from T1 to L5 allowing for very detailed calculation of density, volume and trunk mass. With
this data Pearsall et al. were able to calculate the MOI. An example output of the volume and
corresponding density is shown in Table 4. Although the results were promising, Pearsall et al.
commented that the variations of boundary definitions of the trunk present in the biomechanics

research community make it difficult to generalize findings (Pearsall et al., 1996).

Table 4: Example volume and density outputs along the spine from T1 to TS5 calculated using CT
taken from: (Pearsall et al., 1996)

Trunk Level Volume (cc) Density (g/cc)

T1 810(332.5) 0.99(0.06)
T2 867.1(357.5) 0.91(0.06)
T3 1125.7(134.8) 0.84(0.07)
T4 1180.3(119.8) 0.78(0.09)
T5 1230.6(110.6) 0.77(0.10)

Application of MRI in measuring BSIPs directly from living humans has also been shown as an
acceptable method (examples: (Bauer et al., 2007; Lee et al., 2009; Martin et al., 1989; Pearsall,
et al., 1994)). MRI offers great contrast between various tissues and is advantageous as it does
not expose subjects to radiation (Heymsfield et al., 1997). Using MRI, specific determination of
tissue types and distributions is determined within slices along the length of the segment as
shown in Figure 4. Slice thicknesses vary, and when considered in three dimensions, the image
consists of volume elements known as voxels. Each voxel has a gray scale that reflects the
tissue's composition. In such a way, with both MRI and CT it is possible to discriminate between

bone, skeletal muscle and adipose tissue (Heymsfield et al., 1997).

In an MRI experiment, Martin et al. (1989) showed that there was close agreement between the
criterion (predicted using reaction board and oscillation techniques) BSIP estimates and those

estimated using MRI on 8 baboon body segments. In a larger study, Ho et al. (2013) derived
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BSIP estimates for 50 Chinese men (21.5+1.52 yr.) and the results showed to be comparable to
predication based on cadavers. Ho et al. (2013) stated that the discrepancies in the segment
boundaries and coordinate systems might have contributed to the differences they saw between
methods. They concluded that MRI is currently the most advanced method for studying human
inertia parameters (Ho et al., 2013). However, limitations such as the large associated cost and

time consuming nature of estimating BSIP parameters using MRI make this method restrictive.

Figure 4: Left: MRI images are taken along the longitudinal axis of the segment (adapted from
Ho et al., 2013). Right: Each slice shows the representative fat, bone and muscle tissues (A:
Anterior, P: Posterior, M: Medial, L: Lateral) (adapted from: Lee et al., 2009)

Dual-energy X-ray absorptiometry (or DXA) is a minimal radiation low cost imaging method
which can provide BSIP estimates (examples: (Durkin et al., 2002; Lee et al., 2009; Rossi &
Lyttle, 2013; Wicke & Dumas, 2008)). DXA projects two X-Ray beams of different intensities
on to a subject’s body. Based on the attenuation of the energies as they pass through the body the
mass per area unit can be evaluated. Rossi et al. (2013) showed that subject specific mass can be
estimated very accurately (%RMSE of <1.5%) for the whole body in the 28 subject study.

Durkin et al. (2002) found a mean percent error of whole body mass estimation using DXA
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compared to scale values of -1.05%=+1.32% in the 11 male subject study (Durkin et al., 2002).
Similarly, Wicke and Dumas (2008) observed highly accurate estimates (error < 0.1-0.39%) of
various BSIPs in the 50 participant study (Wicke & Dumas, 2008). Wicke and Dumas mentioned
that 2D characteristics of the results obtained using DXA did not allow for the estimation of the
MOI along the longitudinal or transverse axes or the calculations of the COM position in the
sagittal plane. Shown in Figure 5 is an example DXA setup. DXA has shown to provide
promising results but the technology is not widely available and can be difficult to use in large

subject pools due to cost and time requirements of the method.

X-ray Detector

Alternating X-Ray Beams
(140 KeV /70 KeV)

Scan Bed
HOLOGIC QDR-1000/W
Bone Densitometer

X-Rays Base

Figure 5: Left Side: Example DEXA setup, with each scanning less than 5 minutes. Right Side:
Output image prior to post processing. (Durkin et al., 2002)

The medical imaging technology detailed above could serve as a means of constructing detailed
databases for a wide range of populations. However, the expensive and time-consuming nature
of using this technology in this context makes it difficult to acquire subject specific estimates in a

lab environment. A summary of representative medical imaging literature is shown in Table 5.
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Table 5: Summary of a variety of medical imaging studies from literature used to estimate BSIPs. (Volume (V), Mass (M), Density
(D), Race(R), Caucasian(C)) This does not reflect the extent of full literature.

Subject Pool information Parameter
Reference # Sex Age R BMI \% M COM MOI D Comments

CT

1976 (Huang & Wu, 1976) - - - - - - - - - x  Number of samples not clear, validation study
1983 (Huang & Suarez, 1983) - - - - - - - - - x  Non-human

1996 (Pearsall et al., 1996) 4 221;/[ 46-68 - - X X X X x  Only Trunk

1997 (Erdmann, 1997) 15 M 20-40 - - X X X X x  Only Trunk
MRI

1989 (Martin et al., 1989) 8 - - - - X X X X x  Baboon segments

1990 (Mungiole & Martin, 1990) 12 M 21.8-31.9 - - X X X X x  Athletes

1994 (Pearsall et al., 1994) 26 M 40.5£14.4 - 19.7-39.3 X X X X x  Only Trunk

2000 (Cheng et al., 2000) 8 M 264 Chi - X X X X x  Chinese Adults

2007 (Bauer et al., 2007) 10 F 9.6+0.9 18.5+1.8 X X X X Left Leg

2013 (Ho et al., 2013) 15 M 21.5+1.52 Chi 27.3£2.1 X X X X x  Full body into 14 segments Chinese Adults
DEXA

2002 (Durkin et al., 2002) 11 M 76.04+6.41 - 23.9+1.8 X X X X x  Length was also determined for each segment
2008 (Wicke & Dumas, 2008) 50 22:15[ 1\/}: 2222 52;:‘7 - 15[2223?;1351 X X X X x  Full body

2009 (Lee et al., 2009) 4 M 27.5¢4.6 - - X X X X x  Full Body

o3 mesalwens om0 NEEI o i d 0l o
2004 (Ganley & Powers, 2004) 20 11%1;./[ 23-50 - - X X X X X
Gamma Scanner

1975 (Brooks & Jacobs, 1975) 3 - - - - X X X X x  Legs of lamb

1983 (Zatsiorsky & Seluyanov, 1983) 115 100M M:23.8£6.2 - - X X X X x  Female subjects were national athletes

15F F:19.0+4.0




2.4.2 Mathematical Models

Geometric modeling is a mathematical approach in which shapes are used to represent individual
segments of the body. This can be as simplistic as modeling the body as a combination of
cylinders and spheres (Hanavan, 1964) or as complex as functions that take into account the
complex geometry of individual body segments (Wicke & Dumas, 2010). Whether the model of
the body is simple or complicated, geometric models require anthropometric measures, which

represent the size of the body at various locations, allowing for individualized estimations.

Early work in geometric modeling appeared in the work done by Simmons et al. (1960) who
approximated the body as a set of cylinders and spheres (taken from: Chandler et al., 1975).
Later both Hanavan (1964) and Whitsett (1963) refined the model by Simmons et al. (1960) and
represented the body composed of 16 and 14 segments respectively (Figure 6). The models used
the mass regression equations developed by Barter (1957), which were based on cadaver studies,
for density estimations to solve for the BSIPs. Although the models were rudimentary with many
approximations, these researchers presented straightforward approaches which have served as a

foundation for geometric modeling in this research context (Hanavan, 1964; Whitsett, 1963).
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Figure 6: Geometric models using cylindrical and spherical shapes. These models had a high
degree of estimation resulting in large errors in BSIP estimations. Left Side: 16 segment model
(Hanavan, 1964). Right Side: 14 segment model (Whitsett, 1963)

Some years later, Jensen (1978) presented a geometric model, which used elliptical zones
stacked on top of one another to represent the body. Jensen’s method follows contours of the
body well as shown in Figure 7. Jensen’s model was based on some of the ideas proposed by
Weinbach (1938) of which Dempster (1955) evaluated to be quite suitable for volume estimation
(Jensen 1978). With the Elliptical Cylinder Model (ECM), which Jensen developed, the body
was segmented into 16 segments. The estimated total body mass using ECM resulted of errors of
less than 1.5% when compared to scale measures. Jensen’s experiment showed that he was able
to reduce mass estimation error by approximately 10% compared to the results determined using

the model by Hanavan (1964).
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Figure 7: The Elliptical Cylinder Model (ECM) proposed by Jensen (1978). The model is
designed to be adaptive to a range of body morphologies. Shown is a manually digitized human
subject. The elliptical shapes are based on the counters of the body and adapt to a range of body

morphologies (Jensen, 1978).

In recent years, the ECM model has been used to estimate BSIP of pregnant woman (Figure 8), a
population that is not well represented in biomechanics. The versatility of the ECM model
provides the possibility of estimating BSIPs, without a large amount of training from the

operator or researcher (Dumas et al., 2013; Yessoufou et al., 2014).

Wmﬂmm il lﬂmmmm‘.

Figure 8: Image shows early pregnancy (left) and late pregnancy (right) with the abdomen region
significantly increased in size. The ECM is adapted to estimate BSIPs (Yessoufou et al., 2014).
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A more rigorous model by Hatze (1980) presented a geometrical model requiring 242
anthropometric inputs subdividing the body into 17 segments. The model used gender dependent
density values and did not assume segment symmetry. Hatze used the same body segments as
Hanavan (1964) but modified the shoulder, trunk and buttocks segments to more accurately
describe these locations. Although Hatze’s model is mathematically rigorous however, most of
the calculations can be programed and only the 242 anthropometric input parameters are needed
to evaluate the numerical solutions. An important aspect of the model is that no assumptions
about the coronal symmetry of the abdominal-pelvic or abdominal-thoracic segments are made.
As a result, any severe non-symmetry in the regions such a breasts or large stomach (e.g.
pregnancy or high/low BMI subjects) are accounted for in the parameters, allowing for
personalization. This robustness was to allow for modeling subjects with more pronounced traits
in the torso and abdomen regions, allowing for highly tailored subject specific estimations
(Hatze, 1980). Hatze’s model reports the lowest error between measured and predicted total
body mass (error < 0.5%), but has rarely been used by researchers likely due to the 242
measurement inputs (Robertson, 2013). Figure 9 shows the model alongside a computerized

version that has been proposed by Robertson (2013), which has not yet been evaluated in detail.

28



Figure 9: Left Side: The model presented by Hatze requiring 242 measurements of the body to be
taken Right Side: A proposed computerized model of Hatze’s (1980) model. (Hatze 1980;
Robertson, 2013)

Yeadon (1990) proposed a geometric model composed of 20 body segments and requiring 95
anthropometric inputs for evaluation. Yeadon contended that using ellipses to model the body
(such as those in Jensen (1978)) is done because it is mathematically convenient to do so.
Yeadon proposed stadium solid shapes, a blend of rectangles and semi circles to more accurately
model the segments of the body. Yeadon’s model estimated total body mass with maximum error
of ~3% (Yeadon 1990). Yeadon commented that this error is sufficient due to the reduced
measuring time of 30-40 min compared to 90+ min for Hatze (1980). In both Hatze’s (1980) and
Yeadon’s model the cumbersome demand of 95-242 anthropometric measurement inputs is
problematic. Time requirements and errors association with anthropometric measurements are

some of the inconvenient demands of these techniques.

29



Geometric models present a method of estimating BSIPs. With adjustability, the input
parameters for mathematical models can be easily manipulated. For example, tissue density and
anthropometric measurement inputs are in the control of the operator; this however, requires
assumptions to be made on density values. In the aforementioned models, the input density data
was based on Dempster (1955) and Chandler et al. (1975). However, density values can be used
from other sources such as medical imaging. A limitation of mathematical models is that they
will only be as accurate as the extent to which they model the physical morphology. Other
limitations such as manual measurement requirements and assumptions made on segment shape

must also be considered. A summary of selected mathematical techniques is shown on Table 6.

Table 6: Summary of a variety of mathematical techniques used to estimate BSIPs.

Year Reference # Segments  # Inputs Shape Comments
(Whitsett, 1963) 14 - Cylindrical
1963 shapes
1964 (Hanavan, 1964) 15 25 Cylindrical
shapes
(Jensen, 1978) 16 - Elliptical Inputs are obtained from
cylinders digitization
1978 stacked onto
each other.
1980 (Hatze 1980) 17 242 Vary for every
segment
1990 (Yeadon 1990) 20 95 Stadium solid
2007 (Nikolova et al., 16 33 Cones, Based on Bulgarian
2007) Cylinders and  population
Spheres
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2.4.4 Surface Imaging

A photogrammetric approach of obtaining body surface information has been applied and under
investigation since the turn of the 20" century (example: Weinbach, 1938). With the complexity
in the analysis of biomechanical properties increasing, manually extracting parameters such as
anthropometric measurements can be impractical and cumbersome in practice. Photographic
methods obtain important surface measurements using a computer or camera vision based
system. The acquired measurements can be used as a means of estimating BSIP of body
segments and extracting anthropometric information. When used in conjunction with density
estimates, a variety of BSIPs and anthropometric measures can be estimated with this technique.
Additionally, photographically acquired anthropometric measurements can be applied to
mathematical models or regression-based equations, possibly reducing manual estimation errors

associated with human measurement (Stancic et al., 2009).

Photogrammetric work first appeared in the work of Weinbach (1938). By taking photographs of
subjects (front and side view) Weinbach estimated whole body MOI and center of gravity. He
did this mathematically by constructing curves based on the body surface-area measurements
taken from the photographs and developing the MOI estimations about the soles of the feet
(Weinbach 1938). However, the technology was limited to film cameras requiring the operator to

manually identify and measure body parameters, potentially limiting the accuracy of the results.

More sophisticated work was presented by Jensen (1978) who used a photogrammetric method
to acquire the necessary inputs used for his geometric model (the ECM) (Jensen 1978). From a
frontal and sagittal image, Jensen estimated the volume of the body and manually sectioned the

body into different segments by digitizing the images. Using this information, Jensen showed
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that a variety of inertial parameters such as mass, MOI, and COM could be estimated. For
example, the MOI of each segment is calculated about each of the anatomical axes (which are
based on landmarks placed on the subject by the researcher) and determined by summing the
local and remote terms of each ellipse by applying the parallel axis theorem. Wicke and Lopers
(2003) published a validation study on Jensen’s method where Wicke and Lopers applied the
acquisitions techniques on 20 subjects. They compared subject volume estimations from Jensen’s
ECM to data obtained using water submersion of the subject’s extremities and full body. Wicke
and Lopers concluded that when using a high image ratio in the photographs (taken image to
actual measured size ratio of 1:5) and taking a high degree of precaution is taken during the
digitization of the images, the model by Jensen provides an accurate means of estimating
segment volume of the body (total body volume error of 2.01+/- 2.17%). Wicke and Lopers
noted that a high degree of variance is reduced when the digitizing operator has performed the

digitization procedure at least 10 times (Wicke & Lopers, 2003).

With advancements in photographic technology, Baca (1996) used video recording to determine
the anthropometrics of body segments. Baca applied the developed video-metric method, using a
video camera, to obtain the required anthropometric inputs for the geometric model developed by
Hatze (1980). The researchers found that anthropometric measurements using the video method
did not significantly differ much from direct measurements, an encouraging find (Baca 1996;
Hatze & Baca, 1992). When estimating total body volume, the method had an overall reported
error of 9 %, higher than Jensen’s (1978) ECM model. An important drawback that Baca (1996)
discussed was that attaining the 242 inputs required for the geometric model from the video was

cumbersome. With the 242 inputs, the probability of error in the estimations only increases.
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Norton et al. (2002) used a 3D laser scanner to estimate the mass and COM of the legs. The
results showed leg volume estimates for subjects were all within 1% to that attained using a
water submersion technique and within 2.5% in COM estimations. Attaining leg volume to such
a high degree of accuracy was very promising but at a cost of $120,000 for the scanner the

method is too costly to be widely adapted (Norton et al., 2002).

Stancic et al. (2009) demonstrated the use of computer vision as a means of estimating
anthropometric parameters for use in conjunction with geometric models. An algorithm was
constructed using a 3D computer model of each subject from 2D photographic images as inputs.
The method required no experience in anthropometric measurement acquisition. Results were
compared to that of anthropometric tables obtained from Winter (1990) and to manual
measurements taken by the researchers. The researchers showed that the computer based results
for segment lengths were more personalized than values based on generalized proportion tables
showing the possibility of eliminating the need for manual anthropometric measurements

(Stancic et al., 2009).

As computer vision and laser technology have surged over the recent decade, devices have come
down in price. In one example, Clarkson et al. (2012) used four Microsoft Kinect’s (Version 1,
2010) to estimate the volume of the trunk of a manikin. With an array of Kinect devices
surrounding the manikin torso, Clarkson et al. were able to recreate a 3D point cloud of the torso
in less than 3 seconds. The obtained volumetric results were compared to Yeadon’s (1990)
geometric method and to a gold standard laser scan. The results showed volumetric estimations
with a mean error of 0.04 % and a standard deviation of 2.11%, suggesting the Kinect provided

results of greater accuracy then commonly used geometric models (Clarkson et al., 2012).
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With a growing worldwide interest in the Kinect and its wide availability, Clarkson et al. (2014)
assessed the suitability of using four Kinect’s for estimating the volume of the trunk on living
subjects. The findings were compared to that obtained using Yeadon’s (1990) model once again.
The scanning system on average underestimated volume of the trunk when compared to
Yeadon’s model. Clarkson et al. (2014) speculated that this could have been due to the
limitations of Yeadon’s model in accurately modeling the shape, leading to a consistent
overestimation of the volume. This was only speculation as no gold standard volume estimates
were available for the comparisons in this study. Clarkson et al. found that the Kinect system did
show a promising reliability with an intraclass correlation coefficient (ICC) for 3 repeated scans
across 12 participants of 0.997, higher than that of Yeadon’s geometric model (average ICC of
0.887) deeming it acceptable for use in a healthcare environment where the typical necessary
ICC is greater or equal to 0.70 (Clarkson et al., 2014). The results although promising, were only
for one body segment, the torso, limiting the conclusions that can be made with the use of the

device in this field.

Surface imaging methods have shown to be a promising approach of acquiring volumetric and
anthropometric subject specific approximations to solve for BSIPs. When used in conjunction
with density estimations acquired from other methods, it is possible to use surface imaging to
obtain very personalized BSIPs at a low cost. With the rapid advancement in technology, using
surface imaging technology could potentially eliminate the need to ever take manual
measurements. With the aforementioned success of the Kinect, the device used in conjunction
with other models to estimate BSIPs of living subjects should be investigated. Table 7 shows a

brief summary of surface imaging from literature not all sources mentioned in text.
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Table 7: Summary of a variety of surface imaging studies from literature used to estimate BSIPs. (Volume (V), Mass (M), Density
(D), Race(R), Caucasian(C), Japanese (J)) This does not reflect the extent of full literature.

Subject Pool information Parameter
Year Reference # Sex Age R BMI V M COM MOI L Method Comments
1938 (Weinbach 1938) 8 M - - - - - X - - Photogrammetric
1978 (Jensen 1978) 3 M 8-11 - - X X X X x  Photogrammetric 3 Different Somatotype of
young boys
1986 (Yokoi et al., 1986) 255 1;:/[ 112332 3-15 J - X X X X - Photogrammetric Japanese Children
1993 (Sarfaty & Ladin, 1993) 3 M 2328 - - X X X - Video System
2002 (Norton et al., 2002) 9 1;4 j ; - - x x x - - Laser Scanner Scanner cost ($120,000)
2008 (Gittoes et al., 2008) 5 M 22.8+2.6 - - - X - - - Photogrammetric Athletes
2009 (Stancic et al., 2009) 3 M: 2 ) c - < x ) ) X Photogrammetric Mainly for anthropometric
F: 1 via Computer parameters
2014 (Clarkson et al., 2014) 12 M 22 - 2483 x - - - - Kinect V1 Sensor Only scanned trunk
2015 (Sanders et al., 2015) 11 5192 - - - x x  x X Reliability study Swimmers
2015 (Peyer et al., 2015) 6 M: 4 ) ) ) < x X X ) Pi Camera 18 Raspberry Pi camera
F:2 module




2.6 Microsoft Kinect

The Microsoft Kinect V1 sensor has a build-in color camera, depth camera and infrared emitter.
Released in 2011 specifically for the Xbox 360 gaming console, it has become one of the most
widely available 3D cameras (at a cost of ~$200). There is a large amount of open-source code
and function libraries freely available that provide potentials for the camera is a wide range of
applications. Microsoft has designed many functions for the Kinect. One particularly relevant
feature is Player Recognition & Joint Tracking. With Player Recognition the Kinect is able to
detect people in its view sight then applying Joint Tracking it is able to determine a silhouette of

the person and estimate approximate joint locations.

In recent years there has been much research published in the field of biomechanics using the
Kinect as a quantitative measuring device (examples: Bonnechere et al., 2014; Espitia-Contreras
et al., 2014; Huang, Zhenhao et al., 2013; Ning et al., 2013; Oh et al., 2014; Weber et al., 2011).
The Kinect has also been used as a means of developing 3D avatars of people (Barmpoutis,
2013; Tong et al., 2012) and for determining subject specific anthropometric data for electronic
based fitting rooms (Chang et al., 2013). Clarkson et al. (2012) demonstrated the possibility of
using multiple Kinect V1 cameras for BSIP estimations of the trunk. Clarkson et al. (2014)
demonstrated that using the Kinect for estimating BSIPs of the trunk of living subjects was
reliable and comparable to results produced by geometric modeling (Clarkson et al., 2014).
Acquiring 3D scans of humans and various other objects has also been shown as feasible with
the Kinect as well (Doumanoglou et al., 2013; Lachat et al., 2015; Smisek et al., 2011; Tong et

al., 2012). In 2015 Microsoft released a newer version of the Kinect (Version 2, 2015) capable of
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higher accuracy scanning (Figure 10). A quick comparison of the specs between Kinect V1 and

V2 is shown in Table 8.

Depth Sensor

Depth Sensor B C .
P e (IR Camera+ IR projector)

(IR Camera+ IR projector)

RGB Camera

Kinect V2

Kinect V1

Figure 10: Microsoft Kinect V1 (2011) and Microsoft Kinect V2 (2015). The infrared camera
and projector (depth sensor) as well as the RGB camera are shown for both devices.

One of the most important changes between the Kinect V1 and the Kinect V2 is the depth-
sensing module (which acquires 3D information). The Kinect V1 uses a structured-light method
whereas the Kinect V2 uses Time-of Flight, which uses active sensors to measure the distance of

a surface by calculating the round-trip time of a pulse of light (Kolb et al., 2009).

Table 8: Equipment Specs of the Kinect V1 and the Kinect V2 (Microsoft Corporation, 2015)

Feature Kinect V1 Kinect V2
Colour stream (resolution)  640x480 19201080
Depth stream (resolution)  320%240 512x424
Infrared stream (resolution) None 512x424
Depth range 0.4m —4.0m 0.5m —4.5m
Horizontal Field of View 57° 70°

Vertical Field of View 43° 60°

Skeleton Joint Defined 20 26

USB 2.0 3.0

Operating System Windows 7,8  Windows 8
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2.6.1 Accuracy and Precision

Shin et al. (2013) characterized the spatial accuracy and precision of the Kinect V1 for creating
3D images for use in medical applications. The experiment involved comparing the measured
distances between points on a flat and curved surface with control measurements taken with a
ruler, caliper and CT. The findings showed that on a flat surface the Kinect was able to measure
the distances with errors of less than 2mm and on a curved surface less than 3mm consistently
(Shin et al., 2013). Choppin et al. (2013) calculated breast implant volume with the Kinect V1
and found that volume was overestimated 30.3% for 400g (small implants) and 13.9% for 600g
(large implants). The results suggested that the Kinect V1 might not be the best application for
small object scanning with the smaller implant shown to have a greater overestimation then the
larger one (Choppin et al., 2013). Similarly, Henseler et al. (2014) found that breast volume was
overestimated by the Kinect V1 never more than 10% from the ground truth volume of the
implant. Henseler et al. (2014) found that the reproducibility was high for 4 of the 9 breast
implants scanned but found differences of approximately 10% for the other 5 implants (Henseler
et al., 2014). Meister et al. (2012) scanned a statue with a high accuracy laser scanner and
compared the results to the Kinect V1. Findings suggested that flat surfaces were within a 5-
10mm error (to the true length). Curved surfaces were generally underestimated in volume and
sharp corners showed to be smoothed out (less detail in the scan when compared to laser data)
(Meister et al., 2012). The authors suggested a general resolution of approximately 10mm in
absolute world coordinates for the Kinect V1. Shown in Figure 11 is an example of the scanned

statue.
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Statue Laser Scan  Kinect V1

Figure 11: Left: Statue to be scanned Middle: 3D laser scan showing small detials of the statue
Right: Kinect V1 Scan showing less detail (Meister et al., 2012)

With the release of the Kinect V2, Lachat et al. (2015) showed that the Kinect V2 achieved more
accurate measurement results than the Kinect V1. Kinect V2 estimated distances compared to
measured distances showed a correlation of r =0.99 with standard deviations of around 4mm
when the Kinect V2 was <1.5m to the object and up to 16mm with the Kinect V2 4.5 meters
from object (Lachat et al., 2015). Lachat et al. (2015) also found that the Kinect V2 was much
less sensitive to sunlight, suggesting the possibility of using the device outdoors. Yang et al.
(2015) found similar results showing that the depth accuracy of the Kinect V2 depended on the
scanned objects distance away from the device with general error of less than 2mm within a 2m
distance (Yang et al., 2015). Shown in Figure 12 are the estimated errors at varying physical
distances away from the Kinect as well as varying degrees from the optical lenses of the Kinect

V2.
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Figure 12: The field of view of the Kinect V2 and the associated measurements errors reported
by Yang et al. (2015). At a distance of 1-3 m along the optical view of the lens the error is lowest
(<2mm). (Image modified from original taken from: Yang et al., 2015)

2.7 Summary

The importance of acquiring accurate BSIP measures has been established in the literature.
Cadaveric dissection has provided invaluable preliminary information regarding the shape, size
and BSIP estimates of human body segments. Medical imaging had made it possible for
extracting tissue information from living subjects, paving the way for modeling the internal
composition of the body without the use of cadavers. Geometrical models and regression
equations have proven potential in estimating the shapes of body segments using anthropometric
measurements acquired directly from the subject of interest. However, these techniques can

require a large amount of time and or money. Researchers seeking highly subject specific
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estimates or seeking to model a population of subjects that is not well represented by the
aforementioned modeling techniques (example: pregnant women, children, high/low BMI

subjects, amputees) have limited options that are quick and inexpensive.

Using surface imaging methods researchers can acquire representative images of persons of
interests from which geometric properties can be extracted. However, highly acceptable
methods such as laser scanning require expensive equipment and can require a sufficient amount
of space. With the development of portable scanners such as the Microsoft Kinect V1 and V2,
there exists potential for subject specific BSIP estimations overcoming some of the limitations
seen in aforementioned studies. With the potential of rapidly acquiring 3D scans of subjects,
there is also potential of using the Kinect as a means of rapidly estimating BSIPs of subjects with
virtually no morphological restrictions and minimal invasiveness. With the Kinect V2 shown to
be more accurate at acquiring quantitative measurement results, exploring the use of this device
in the context of subject specific BSIPs is necessary. The upcoming section, Chapter 3, presents
a experimentally developed method, which utilizes the Kinect V2 as a research tool for

estimating subject specific BSIPs.
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Chapter 3
Methods

3.0 Subjects

Subjects were recruited from Queen’s University campus by the use of posters and word of
mouth. Before testing, participants read and signed an information package and consent form
approved by Queen’s University’s Ethics Board which is shown in Appendix A. All participants
were explained the Kinect and ECM protocol and the purpose of the study prior to data
collection. Ten male and eleven female participants were recruited for the study. Participants
were asked to wear form-fitting attire such that the contours of their body could be easily
determined. Specifically, male volunteers wore forming-fitting shorts and either a forming-fitting
shirt or no shirt at all. Female volunteers were given the option between wearing long or short
forming-fitting pants and a sports bra or a form-fitting workout shirt. All participants were asked
to wear a swim cap on their head to control hair. There were no exclusion criteria for the

participants. Each participant was weighed three times on a calibrated medical scale and the
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average mass was recorded. Mean age and morphological measures of the subjects was

collected and is shown in Table 9.

Table 9: Average and standard deviation for age, height, weight, and body mass index (BMI) of
the participants

Subjects  Age (Years) Stature (m) Mass (kg) BMI (kg/m?)
(l‘lfj‘i‘(*)s) 23.4(1.7) 1.79(0.06) 75.66(4.5) 2265(2.14)
P;‘:l‘i‘i‘i‘;s 223(24) 1.73(0.09) 70.18(7.8) 233(2.25)

3.1 Experimental Setup

3.1.1 Anatomical Land Marking

Anatomical landmarks were determined through direct palpation of the body. Once the operator
determined each landmark a marker was placed on the surface for reference. Non-reflective color
markers were used for this. Reflective markers such as those commonly used in gait studies were
dismissed because interference between the markers and the Kinect was observed (Figure 13). In
order to be able to identify the markers in the post processing stage of the experiment, markers
with a high color contrast with the subjects skin were used (2cm diameter). This required that
subjects be scanned in full color, a feature available with the Kinect (Microsoft Corporation,

2015).
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Figure 13: Example of interference caused by reflective markers shown on a manikin subject

The specific anatomical landmarks and respective definitions are shown in Table 10. After the
landmarks were identified in the frontal and sagittal planes on the body, a thin band of adhesive
tape (duct tape) was wrapped around the limb at the specific location connecting the two
markers (frontal and sagittal). This was done for each set of landmarks. These bands (of tape)
defined the proximal and distal boundaries for body segment segmentation. Tape was used
because it is non reflective, adheres well to the body, does not affect volume measurements, and
comes in a variety of contrasting colors which show up well on the scans. Figure 14 illustrates a
subject outfitted with the color markers and tape approximating segmentation boundaries and

anatomical landmarks.
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Figure 14: Example of subject outfitted with anatomical segmentation boundary tape and non-
reflective tape for anatomical landmark identification
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Table 10: Body Segment definitions used for anatomical segmentation. Bony landmarks were marked with high contrast tape in the

front and right side view of the subject. A total of 26 marks were used to indicate landmarks.

Landmarks Segmentation Boundaries Comments
Body Front View Right Side Segment Proximal or Ventral Distal or Caudal
Segment Name
Head + 1. Apex of the Head 2. Apex of the Head Head Apex Frontal plane at height Segmentation on the
Neck 3. Tipofthe Chin(at 4. Right Side view Neck of C7 transverse plane at the cervical
C1 level) along Chin line C6-C7 landmark defined in
frontal plane
Torso 5. Front at level with 6. Centre of torso at Upper Frontal plane at height Xiphoid
C6-C7 level with front Trunk of C7
7. Xiphoid 9. Xiphoid Abdomen Xiphoid Umbilicus
8. Umbilicus (L3-L4)
10. Iliac Crests Pelvis Umbilicus Plane roughly through See
11. Pubis the iliospinales at an Figure 25
angle of 37° to the
midsagittal plane
Arm 12. Tip of 3" digit 13. Tip of 3" digit Hand Stylion -
14. Center of Styloid 16. In line with Styloid Forearm Radial Stylion
15. Center of Elbow 17. In line with elbow
Joint joint
18. Acromion Upper Acromion* Radial Segmentation through the
Arm acromion by sagittal plane
with arm abducted at 90°
Leg 19. Atlevel of Greater ~ 21. Greater Trochanter Thigh Plane roughly through Tibiale Distal cut is at approximate
Trochanter the iliospinales at an plane defined by Femoral
20. Patella at level of 22. At level with angle of 37° to the condyles
femoral condyle femoral condyle midsagittal plane
23. Atlevel of lateral 24. Lateral malleolus Shank Tibiale Sphyrion
malleolus
25. Tip of the longest 26. Tip of the longest Foot Sphyrion -
toe toe

* based off of boundaries definitions from Zatsiorsky and Seluyanov (1983)
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3.1.2 3D Scanning

The Microsoft Kinect V2 camera sampling at 30Hz rested on a height adjustable tripod
(Manfrotto Professional Tripod). The Kinect was connected via USB 3.0 to a system operating
Window 8.1 (Graphic Processor Unit: GeForce GTX 970, Motherboard: Z97 Gaming 3 Intel).
To allow for a greater distance between the camera and the computer, a 30-foot active USB 3.0
extension cord (SuperSpeed USB 3.0 Active Extension) was used. Acquisition software, 3D
Builder (Microsoft Cooperation, 2015), available freely through the Microsoft App store, was
used as an acquisition tool in this project. Other software was explored and custom software was
also written but due to its reliability and overall ease of use, 3D builder was deemed as the best
choice for the project requiring minimal training and being easily accessible. Shown in Table 11

is a brief comparison of software that was explored for data acquisition.

Table 11: Software explored for 3D data acquisition using the Kinect

| Software Positive Negative Price
Microsoft 3D = Color = Restrictive settings = Free
Builder scanning =  Minimal features
= User friendly
Kinect Fusion = Highlevelof = Consistent crashing = Free

adjustability = Inconsistent scan outputs
= Many features = Color scanning was

inconsistent
Custom = Fullrange of = License required = Large time
MATLAB adjustability = Complex no GUI requirement
Software

All of the 3D scanning was performed in private lab environment free of distractions. Each
subject was asked to stand in a specially marked location. A circle drawn on the floor indicated
the scanning path of the camera. The subject was asked to stand at the centre of the circle on top

of an elevated transparent platform. This platform served as a means of separating the subject’s
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feet from the ground because it was elevated. Secondly, the platform eased segmentation of the
feet because the point cloud data from the floor would not be captured together with the feet. As
the platform was transparent it did not show up in the scans. The subject was asked to stand in
such a way that their feet were at the furthest edges of the platform and their arms abducted
approximately 90° to the torso as shown in Figure 15. This posture was chosen as it allowed for
visibility for the camera to capture beneath the arms and in between the thighs, maximizing the
potential accuracy of the scan. With the arms and legs closer to the body inaccuracies were
visible in the scans (small gaps between adjacent body segments were not well represented) as
shown in Figure 16. A similar phenomenon was observed with the hands. When the hand was
scanned and not fully extended meaning there was ‘cupping’ in the palms, which resulted in
additional points being estimated in the area. Similar observations were noted by other
researchers as well when using surface imaging techniques (Peyer et al., 2015; Wicke & Lopers,
2003). As a result, subjects were asked to keep their palms fully extended during scanning to

reduce any errors.

Figure 15: Pose adopted for 3D body scanning. Abducting the arms and legs allowed for
minimum visual inaccuracies in the scans.
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Once the subject was ready, they were alerted that during the duration of the scanning process
they were to remain as still as possible. Subject limb movement, specifically of the arms
swinging, created noticeable scanning errors. As result each subject was asked to breathe
shallowly during the duration of the scan and try to stay as still as possible avoiding swinging

their arms.

e

Figure 16: 3D scan of manikin showing visual inaccuracies under the arm and by the hand

To begin the scanning protocol, the Kinect was placed in front of the subject at a distance of 1.5
meters, within a minimum error range ((error < 2mm from: (Yang et al., 2015)) . This also
ensured that the whole subject was visible to the camera. An assistant operating the computer
began the data acquisition in 3D Builder to ensure that everything was running. Data acquisition

Size was set to one step below large and Detail set to maximum. This setting allowed capturing
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at maximum resolution without capturing too much of the environment around the subject. A

link to a video of the scanning process is provided (https://youtu.be/s1cVydEvEp8). Once the

camera was running, a vocal count down was used to prepare the subject for the scan. Another
operator then began to revolve the Kinect by walking around the subject in a clockwise direction
at a height of approximately 1 meter from the ground following the circular path outlined on the
floor. During this process the camera was held in such a way that the lens was facing towards the
subject with the subject central to the focal point, minimizing distortion. Once one full revolution
was complete the camera was manually elevated to approximately 2 meters from the ground and
a counter-clockwise revolution around the subject was then performed. Once the camera was
back to its original starting position (after 1 full clockwise revolution and 1 full counter
clockwise revolution) the computer operator clicked save and the scan was finished. The subject
was immediately notified that they could move again. The scan duration on average took 20-30

seconds.

Following each scan the data was reviewed to ensure no major errors occurred during this
process. Once the scan was deemed adequate, meaning without any obvious visual inaccuracy, it
was saved in the polygon file format (.ply). The scanning process was then repeated until three
adequate scans of the subject were acquired. Most subjects required five scans before three
acceptable scans were saved. Polygon file format ensured that a variety of properties could be
stored including: color, transparency and the texture coordinates. Each subject scan was given a
unique identifying code to ensure subject anonymity. Shown in Figure 17 is an example of a raw
output scan following protocol. Figure 18 shows a schematic of the full setup, which was

described above.
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Figure 17: 3D body scan of a subject identifying anatomical segmentation boundaries and
landmarks.
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Figure 18: Setup schematic for Kinect scanning protocol. The Kinect followed a circular path of
movement around the subject starting in a clockwise direction (at 1m off the ground). Once a full
loop was complete the Kinect was walked back in counter clockwise direction at an elevation of
approximately 2m (1m higher).
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3.1.3 Elliptical Cylinder Model

The photographic method based on the elliptical cylinder model (ECM) developed by Jensen
(1978) was used as a comparison tool in this project. The subject specific ECM has been
evaluated by Wicke and Lopers (2003), with reported total body mass errors of less than 2%
when compared to water submersion techniques (gold standard technique). The Slicer software
written by Mcllwain (Mcllwain 1998) implements the model using two orthogonal photographs
as inputs. The minimal training required and subject specific nature of the outputs will allow for

an appropriate comparison to be made to that of the results collected using the Kinect.

Two digital cameras (Fujifilm Finepix AX 660) were placed 5 meters from a designated platform
at which the subjects stood. The shooting mode was set to ‘auto’ on both cameras and the image
size adjusted to 4608x3440 shooting at 16 mega pixels. The first camera was positioned in front
of the participant, with the camera parallel to the frontal plane of the subject. The second camera
was positioned to the right of the participant, with the camera parallel to the sagittal plane of the
subject. Commercial meter sticks with reflective tape on the ends were hung in the sagittal and
frontal planes and reflective markers were placed 1m apart on the floor. The meter sticks and
markers served as a mean of scaling the photographic images in the post processing part of the

experiment. A full experimental schematic is shown in Figure 19.

Each participant was asked to stand on a small platform which was angled 20° to the floor. This
allowed for maximum exposure of the feet to the optical view of the camera. To make sure the
hand was positioned properly, participants were asked to keep their fingers together and flex
them to the point before hyperextension, as recommend by Wicke and Lopers (2003). The

participants were also asked to internally rotate their hands until the minimal amount of area
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could be seen in the right side view (as shown in Figure 20-B). Two operators were required to
capture the photographs. This was to ensure that the photographs were taken as close as possible
to the same instant. Once the participant was appropriately positioned a verbal countdown was
issued and the photographs were taken. This was repeated 3 times to ensure that an adequate set
of photographs was captured. Anatomical markers, which were in both the frontal and sagittal
plane (as described in Table 10), were used later for the digitization and segmentation in post
processing. Before the subject was asked to step off the platform the photos were quickly

inspected for any visual imprecisions, none where rejected.

The subject images were imported to the computer and given a unique identifying code to ensure
that each set of frontal and side images were appropriately matched. The photographs were then
cropped to include only the subject and the meter sticks in the image. The cropping was done in
such a way that all of the photographs maintained an aspect ratio of 4x3, based on the
recommendations by Wicke and Lopers (2003). One set of photographs (frontal and side view)
was chosen for each subject and imported into Slicer. Once in Slicer the digitizing process is
simply the process of using a mouse to click around the contour of each segment. The operator’s
experience level is considered negligible relative to between-operator variations (Wicke and
Lopers 2003). Therefore, a single trained operator digitized all of the participants to ensure
consistency. The segmentation boundaries are detailed in Table 10. For the segmentation of the
pelvis a computerized protractor was used to ensure that a 37° boundary from the pubis along the
midsagittal plane was defined. Once all digitizing was completed, the segments BSIPs (volume,
MOI, COM and length) were computed as in Jensen (1978). An example of a fully digitized

participant can be seen in Figure 20.
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Figure 19: Side and Front view of Jensen 1978 ECM photographic method setup used for
estimating subject specific BSIP. Participants stood on the platform (not to scale).
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Figure 20: A. Front and B. Side view showing manual segmentatlon outlines defining segment
boundaries. C. Graphical output from Slicer software showing segment centers of mass (yellow)

and proximal and distal landmarks (blue)

3.2 Post Processing

3.2.1 Software

The Kinect data post processing was done using Meshlab (64 Bit Version 1.3), Natfabb (Basic
Version 5.2) and custom MATLAB (2012 Version A) Code. Meshlab was chosen because the
software allowed for easy GUI manipulation of point clouds and has been widely used by
researchers (Kramer et al., 2012; Shin et al., 2013; Wheat et al., 2011). The open source nature of
Meshlab as a mesh process tool was another reason that the software was chosen. The widely

cited algorithms within Meshlab permit for easy reference to literature from GUI functions. This
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enables for free access to the software with minimal training required (Cignoni et al., 2008).
Netfabb, which is also a widely available free of charge software, was used only in the first step
of mesh editing explained in Section 3.2.2. Custom dedicated MATLAB script was written for
extracting specific triangular mesh information which otherwise would be time consuming and

difficult to do for a large amount of scans although possible to compute in Meshlab.

3.2.2 Mesh Editing

In raw form each 3D Kinect scan had small holes within the point cloud data, which needed to be
filled in prior to any analysis. Creating a mesh to enclose a cloud of points is a common step
when working with point clouds. Meshlab has a variety of reconstruction algorithms, which
create a triangular mesh of the imported point cloud, filling in all small holes. Under Filters>
Remeshing, Simplification, and Reconstruction there is a wide range of options to choose from.
An example is a Poisson reconstruction created by Kazhban et al. (2006). However, in some
cases surface reconstruction can take away important details from the scans such a facial features
(Shin et al., 2013). Minimal reconstruction of the point cloud will provide the clearest idea of the
accuracy of the results obtained from the Kinect. Meshlab offers an option to Fill Holes. This
process triangulates together the points in a cloud forming a mesh, effectively enclosing the point
cloud to be a watertight mesh meaning no spaces or gaps exist between points. Meshlab does not
allow for an automated process of filling in holes, each hole must be selected manually. This
would require a large amount of time and would be impractical. Netfabb provides a function
Close Trivial Holes under Repair->Actions->Close Trivial Holes, which performs this action
automatically. The scans were all imported into Netfabb and trivial holes were closed. All of the

files were saved as .ply files
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3.2.3 Alignment

After the scans had a triangular mesh from the fill hole procedure, each subject scan was
individually imported into Meshlab. However, importing the raw scans resulted in the scans not
being aligned to any particular meaningful axis, making it difficult to segment the body in any
meaningful way (Figure 21-A). The solution to this was to align each scan in such a way that any
cuts that would be made would be perpendicular to the frontal plane of the body. The simplest
solution was to align the scans to a principal axis about the body’s COM. In the menu under
Filters> Normal, Curvatures and Orientation> Transform: Move, Translate, Center moved the
center of the mesh to a global axis that was central to the geometry of the object. Check marking
Translate center of box to the origin and Freeze Matrix then clicking apply shifts the scan
(Figure 21-B). Next under Filters> Normal, Curvatures and Orientation> Transform: Align to
Principal Axis and checking Use vertex and Freeze Matrix aligns the z-axis along a longitudinal
plane of the body scan (Figure 21-C). Shown in Figure 21 is an example of this full process.

Once the scan has been aligned it was possible to begin segmentation.

z LONG (+2)

LATERAL (+y)

ANTERIOR
(+x)

A. Imported Scan

B. Shift to Center C. Aligned to Principal Axis

Figure 21: A. Imported Raw Scan B. Shift to Center of Meshlab Global Axes C. Alignment to Principal
Axis of the scan about the COM.
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3.2.4 Segmentation

Body segmentation for the 3D data was performed in Meshlab using the Select Vertices option.
Referring to the anatomically marked locations on the subject (detailed in Table 10), manual
segmentation was possible based on these visual cues. The tape bands were visible in the scans
and were used as boundary guidelines for segmentation. Prior to segmentation the camera view
was adjusted under Windows>View From>Top in order to ensure that the view on the screen was
such as that of Figure 10. Such view, with the scan perpendicular to the cutting plane, made the
segmentation procedure possible and intuitive, as demonstrated in Figure 22 where an example
of the middle trunk segmentation is shown. Using the Select Vertices feature, vertices were

selected and deleted using Delete Selected Vertices until the desired segment remained.

A. Aligned Scan B. Inferior Selection

—a l:> —

C. Superior Selection D. Middle of Trunk Segment

Figure 22: A. Raw Scan Aligned to Principal Axes showing tape which defined cutting location B.
Vertices Selection of Lower Limbs. C. Lower Vertices Deleted and Upper Body Vertices Selection D.
Segmented Middle Torso Segment.
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Body segmentation always resulted in the shape to be hollow as shown by Figure 23-A. Using
the holes filling algorithm found under Edit>Fill Hole, simple holes resulting from segmentation

were easily filled, a necessary step required for calculating volume and inertial parameters later

0@

Figure 23: Lower Trunk Segment A. Hollow from segmentation B. Selecting holes to fill C. Holes filled.

in steps of the protocol.

A specific segmentation order was followed to ensure consistency between scans. The order was
based on first segmenting the segments which were on the extremities of the body then moving
inwards, as detailed in Table 12. The pelvis and upper torso were not segmented rather they were

the last two segments remaining after all of the other segments were cut.

Table 12: Body segmentation order starting with the 1* and moving towards to the 3™

1™ Head, Hand and Foot (Right and Left) [5 segments]
2 Abdomen, Forearm and Shank (Right and Left) [5 segments]
3¢ Thigh and Arm (Right and Left) [4 segments]
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To ensure that segmentations did not overlap with one another a specific system was developed.
Following the order of segmentation detailed in Table 12, the first 5 segments would be dyed a
different color and imported back into the scan then deleted. A detailed example of this is shown

in Figure 24.

"

A. 1st 5 segments B. Vertices Deleted

-

— || R
F. Vertices Deleted Upper

D. Vertices Deleted E. Last 4 segments Trunk and Pelvis remain

Figure 24: Body segmentation protocol following segmentation order detailed in Table 12. A.
The first 5 segments B. Vertices deleted C. Second 5 segments D. Vertices Deleted E. Last 4
segments to be imported and dyed F. Vertices deleted and the trunk and pelvis remain.

Each body segment was given a unique identifying code. To dye the segment under Edit->Z-
Painting each body segment was dyed a specific color. Once the segments were ready to be
imported back onto the original scan the original scan was opened in Meshlab and the segments

dragged into the software. Next under Filters->Vertex Attribute Transfer the color from each
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segment was transferred to the original scan (such as in Figure 24-A). Max Dist Search, an
option in the pull down menu, samples points within a specified distance of the imported
segment being transferred. This was set at 0.01%. Once each segment color was transferred to
the original scan the color vertices were selected. Under Filters->Select Face by Color the
specific segment color was selected and then the vertices were deleted using Delete Selected

Vertices (Figure 24-B). This process was repeated as depicted by Figure 24 A-F.

The 37° plane cut which is made at the upper thigh region was done by rotating the scan 37°
(Filters->Normals, Curvatures and Orientation->Tranform:Rotate) about the anterior-posterior
axis (x-axis defined in Figure 25). Then with the Select Vertices option the cut was made from

the pubis. The resultant body scans after segmentation resembled that of Figure 25.

Head+Neck

Hand

Forearm

Abdomen

h '

Shank |

_1
Foot ‘ l: ‘-\
Figure 25 : Body scan post-segmentation. A total of 16 body segements are shown.
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3.3 BSIP Evaluation

The volume, mass, COM, MOI and segment lengths were all evaluated as an average between
the left and right side of the limbs, meaning all of the BSIPs were calculated for each 16
segments but the average value of the left and right side for the BSIPs was reported in the results.

The following section overviews how the BSIPs were acquired in post processing.

3.3.1 Import STL

All of the .ply files were converted to sterolithography files (.stl) for the purpose of analyzing in
Matlab. Each subject had 16 separate .stl files representing the 16 body segments. Open source
code by Adam H. Aitkenhead (READ_stl from Matlab Community) was used to import the .stl
files into Matlab structures. A link to the code file is provided in the Appendix B. Once the scan

was imported into Matlab, the BSIP were evaluated.

3.3.2 Segment Volume

The volumes of the point clouds were calculated based on the method detailed in Eberly et al.
(1991) using divergence theorem from calculus as represented by Equation 3. Integration of an
area over the boundary of the region formed by the triangular mesh is used to solve for volume.

Code written by Anwar M. Upal was modified and implemented into the BSIP calculation

[[1#-as= [[] awar

Equation 3: Divergence theorem relates surface integral to a triple integral. S is the boundary of
solid W

software.
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3.3.3 Segment Mass

Determining the mass of each segment (1M, gment,i) required multiplying the found volume of

each segment (Vsegment,i) by an assumed corresponding density (pdensity,i)’ as depicted by

Equation 4. The densities, which were used to solve for mass estimates, are shown in Table 13.

Mgegment,i segment,i * Pdensity,i

Equation 4: Segment mass equation to solve for the mass of each segment

Table 13: Body segment densities used in the experiment.

Body Segment [lzzl;sritg] References
Head+Neck 1070%* (Clauser et al., 1969)"
Upper Trunk 820

Abdomen 1010 (Pearsall et al., 1994)*
Pelvis 1020
Arm 1060
Forearm 1100
Hand 1105

Thigh 1040 (Clauser et al., 1969)"
Shank 1080
Foot 1080

*This density measure reported is for the head not the head+neck

! Taken from cadaver measurements (n=13)
>Taken from MRI measurements (n=26)
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Each segment mass was presented as percentage of total body mass calculated using equation 5.

Mgsegment;

Z(msegmentsi)

Equation 5: Equation for percentage body mass

%mtota] - ' 100%

3.3.4 Moment of Inertia

The MOI was solved about the COM of each of the segments about axes that represented the
principal axes of the segments. This resulted in an inertia matrix with only diagonal terms Ixx,
lyy, Izz, the principal moments. As constant density was assumed throughout all of the body
segments the principal axis also represents the axis of rotational symmetry of the segment
(Kibble & Berkshire, 2004). To calculate the moment of inertia, code written by Anwar M. Upal
was used which is also based on the Divergence Theorem of Calculus. After the MOI was

evaluated, the matrix was multiplied by the estimated density value of each segment.
3.3.4.1 Meshlab

Alternatively, Meshlab provides a function to compute the volume, inertial tensor, and cosine
matrix (inertial axes definitions) of a 3D mesh. This information can be found under
Filters>Quality Measures and Computations>Compute Geometric Properties. In order to view
the information the Layer Dialogue window has to be opened under View>Show Layer Dialogue.
In Meshlab, outputs are all displayed in centimeters units as opposed to meter. Caution needs to

be taken, as the numerical display is limited to 8 digits.
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Inertial estimations determined using Meshlab assume a density value of 1, as such the estimated
inertial parameters (Imesh,i) need to multiplied the by the corresponding density of each body

segment. The results obtained using Meshlab were identical to the estimates from Matlab.

3.3.5 Length and Center of Mass

The centroid was determined by calculating the geometric centre of the cloud of points
representing each segment. This assured that the centroid is not simply an average of all of the
points within the cloud. Taking the average is an alternative approach but caution should be
taken because the average will not always represent the true center of the point cloud. If for
example the point distribution (density) was not even throughout, meaning there is a higher pool
of points in certain locations of the cloud, then this would pull the centroid towards this
direction. By estimating a physical centroid based on the geometry rather then the average of the
points in a point cloud, the outcome is a better representation of the center. An example of the

geometrical centroid of a forearm segment compared to the mean location is shown Figure 26.

Figure 26: Forearm segment showing geometric centroid (red) and centroid based on the average
of point cloud points (green)
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To determine a relative distance of the COM from a segment endpoint, an algorithm was
constructed. The eigenvectors of the principal MOI of each segment were determined. Next,
using the axis, which represented the longitudinal axis of the segment (defined as 1zz), a vector
along this axis was projected until the vector intersected the boundary of the segment. This was
done in the positive (+1zz) and negative (-Izz) direction such that two segment endpoints were
determined. An example of this is shown for the thigh in Figure 27 where the distal intersection
point and proximal intersection point of the long axis are visible. A length calculation based on

the distance between two points in 3D space was applied (Equation 6).

2 2 2
LengthSegmenti = (Xproximali - Xdistali) + (Yproximali - Ydistali) + (Zproximali - Zdistali)

Equation 6: Equation used to calculate distance between points in 3D

Longitudinal Length

Distal Interection Point

Centroid

Proximal Intersection
Point

Figure 27: Calculation of segment longitudinal length. An example of the thigh is shown. The
intersection points approximate the joints.
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Finding the longitudinal length by approximating two segmental endpoints provided a relative
distance to be calculated between the proximal/distal location of each segment and the centroid,
allowing for the centroid to be represented as percentage distance from an end of the segment.
An example of the resultant output from this procedure is shown in Figure 29 where the thick
lines represent the distance from the proximal end of each segment to the estimated geometrical

center.

3.3.6 Exceptions

The principal axes about the COM of the head, upper trunk, abdomen and pelvis did not coincide
with any meaningful anatomical orientation as shown in Figure 28 (left side). To report the
BSIPs with respect to a more meaningful orientation, a transformation to a global anatomical
axis was performed. This allowed the intersection of the z-axis (coordinate system shown in
Figure 28) to define the cranial and caudal ends of these four segments. As all of the subjects
were standing in an anatomical posture in the 3D scans, adjusting the axes to coincide with
anatomical axes is reasonable. The head and trunk region is approximately symmetric about the
midsagittal plane in this orientation. Due to this symmetry it is customarily assumed that the
principal axes of inertia of these segments are close to the cardinal anatomic axes through the

corresponding COM (Zatsiorsky 2002).
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3

Figure 28: Left Side: Principal axis of rotation represented by the Eigenvectors of the MOI about
the COM. Right Side: Axes Transformed to coincide with global axis. This transformation

allowed for reporting the values in cardinal axes with the z-axis representing the cranial-caudal
direction.
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Figure 29: 3D point cloud of human body. Thick lines represent a connection between the
centroid of each segment and the proximal end of the segment (cranial endpoints of the
head+neck, and torso region).

3.3.7 Coordinate Systems

The coordinate system definitions are shown in Figures 30-32 from all of the respective body
segments. The Thigh, Shank, Arm, Forearm, and Hand are all in the principal axes of the body
segments. The Head and Torso region is represented in cardinal anatomic axes based on the
anatomical upright posture during scanning. Foot axis was adjusted such that the z-axis passes

along the length of the foot approximately from the toe to the heel.
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Figure 30: Definitions of coordinate systems of the Head, Upper Torso, Abdomen and Pelvis. The x-axis represents the
anteroposterior axis, the y-axis the medial-lateral axis and the z-axis the cranial-caudal axis.

Figure 31: Definitions of coordinate systems of the Thigh, Shank and Foot. The x-axis represents the anteroposterior axis, the y-axis
the medial-lateral axis and the z-axis the proximal-distal axis. The foot axes are defined to better match the anatomy of the foot with
the z-axis passing from the heel to the toes.
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Figure 32: Definitions of coordinate systems of the Arm, Forearm and Hand. The x-axis represents the anteroposterior axis, the y-axis
the medial-lateral axis and the z-axis the cranial-caudal axis.
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3.4 Scanning of Cylindrical Object

To measure the accuracy and precision of the measurement results of the Kinect V2 used in this
experiment a hollow cylinder was scanned 25 times following the proposed protocol. Cylindrical
parameters were determined using a tape measure of accuracy +0.1cm. The longitudinal length
was determined as the length from one endpoint to the other. The COM was predicted to be 50%
from either endpoint of the cylinder, as it was assumed to be perfectly symmetrical. The BSIPs
were determined as detailed in this experiment. Supplementary information is provided in the

Appendix C.

3.5 Comparisons to Literature

The estimates obtained using the Kinect and ECM methods were compared to results obtained in
literature. Specifically, data compiled by Zatsiorsky and Seluyanov (1983) was used. In their
experiment 115 subjects were recruited and analyzed. In their experiment a medical imaging
method the Gamma-Scanner was used to estimate BSIPs. Zatsiorsky and Seluyanov (1983)
presented regression equations to solve for mass, COM and MOI using subject body weight and
height as inputs. The subject pool used in the study closely matched the subject pool from this
experiment as well as the large subject pool (Male (n=100), Female (n=15)) were reasons as to
why these experimental results were chosen for comparison purposes. The subject data from
Zatsiorsky and Seluyanov (1983) is shown in Table 14. The regression equations are shown in

the Appendix D.
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Table 14: Anthropometric data of subjects from Zatsiorsky and Seluyanov (1983)

Subject Age (Years) Height (m) Mass (kg)
Male
(n=100) 23.8+6.2 1.74+0.062 73.0+9.1
Females
(n=15) 19.0+4.0 1.74+0.033 61.9+7.3

The data from Zatsiorsky and Seluyanov (1983) is reported with the subjects all standing in an
anatomical posture upright with arms straight down at the sides of the body, palms turned
forward and head erect. As the segmentation in this project is based on Zatsiorsky and Seluyanov
segmentation protocol, the segmentation is as that detailed in Table 10. The MOI are all taken
from this position with the anteroposterior axis represented by Ixx the mediolateral axis
represented by lyy and the longitudinal axis represented by Izz. The only exception is the foot
with the MOI given for an imaginary position with the foot rotated outward. The axis which is
parallel to the flexion axis at the ankle joint is the anteroposterior axis and the axis from the heel
to the tip of the second toe is the longitudinal axis (Izz) (defined in : Zatsiorsky & Seluyanov,

1983). The foot axes were adjusted in this experiment to match this definition.

The longitudinal length and COM results, which were used for the comparisons, were based on
the definitions shown in Table 15. For the foot, head and torso region the anatomical length was
used for comparing the longitudinal length and the COM estimates. This was the case because
the anatomical length origin and endpoints were closer related to that of this experiment. For the
remainder of the segments the biomechanical lengths were compared. The biomechanical lengths
are modified definitions written by Paolo de Leva (1996) based on Zatsiorsky and Seluyanov

(1983) (Paolo de Leva, 1996).
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Table 15: Segment length definitions used to determine longitudinal length. The longitudinal
length is based on the distance between the origin and endpoint of each segment

Segment Origin Endpoint Length Type ‘
Head + Neck Head + Neck Vertex Cervicale Anatomical *

Upper Trunk Cervicale Xiphoid Anatomical

Torso Abdomen Xiphoid Omphalion Anatomical
Pelvis Omphalion Pubis Anatomical
Upper Arm Shoulder JC Elbow JC Biomechanical**

Arm Forearm Elbow JC Wrist JC Biomechanical
Hand Wrist JC Third Dactylion =~ Biomechanical
Thigh Hip JC Knee JC Biomechanical

Leg Shank Knee JC Ankle JC Biomechanical
Foot Heel Tip of longest Anatomical

toe (Acropodion)

__* From (Zatsiorsky, V. & Seluyanov, 1983)
** Modified version of (Zatsiorsky, V. & Seluyanov, 1983) done by (Paolo de Leva, 1996)

The experimental setup and more details regarding the study, the full results and the subject pool

can be found in the book: Kinetics of Human Motion (Zatsiorsky 2002).

3.6 Statistical Analysis

A t-test for dependant means (paired samples t-test) was used to compare the results found for all
of the BSIPs across the female and male subjects (Equation 7). A two-tailed hypothesis was
assumed. Significance was determined based on three levels: p<0.05 (*), p<0.01(**),

p<0.001(*%%).
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(%)
-
(N — 1N

Equation 7: Paired sample t-test where N is the number of samples and D is difference between
samples

A Tukey mean-difference plot (Bland-Altman plot) was used to identify if there were differences
between the volume estimates between the ECM and Kinect methods. The agreement between
the estimates could therefore be determined. Pearson correlation was also used to determine

agreement between methods.

To evaluate the reliability of the volume estimates from the 3D scans the intraclass correlation
coefficient (ICC) was calculated. This was done for the total volume estimation and the
segmentation protocol. For the total volume the volumes from the three Kinect scans were
compared with one another for each subject. A single scan from each subject was chosen at
random and segmented two times following the protocol. The resultant segmental volumes were

compared with one another and the ICC reliability was computed.
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Chapter 4
Results

4.0 Acquisition Time

Total experimental acquisition times are shown in Table 16. Lab setup times are based on
preparing the equipment necessary to perform the experiment with required software already
installed on the computer. Anatomical land marking constitutes the majority of the time with the

subject for both the ECM and Kinect methods.

Table 16: Experimental pre and post processing time across three methods.

Kinect V2 Zatsiorsky Regression
Lab setup time ~15 minutes ~45 minutes N/A
Subject ~30 min ~20 minutes anatomical ~2 minutes (acquire
Interaction Time (Anatomical land land marking weight and height)
marking) ~2 minutes
~2 minutes (anthropometrics)
(anthropometrics) ~10 seconds / photo
~30 seconds/scan
Post Processing ~45 minutes/scan ~25 minutes/subject ~5 min
Total Time ~1.5-2 hours/scan ~1.5-2 hours/subject ~10 min/subject

77



4.1 Test Object Scanning

A plastic cylinder of measured length was scanned 25 times. Inertial parameters estimated using
the developed protocol were compared to theoretical values. The results are shown in Table 17.
Supplementary data is provided in the Appendix C. The results show that the experimental
volume was overestimated on average by 209 cm’. The longitudinal length and COM% were
underestimated by 0.5 cm and 0.2% respectively. The values for the MOI obtained with the
experimental method were overestimated by less than 2% for the Ixx (anterior-posterior) and lyy

(medial-lateral) and within 8% of the Izz (longitudinal).

Table 17: Comparison between theoretical and experimentally obtained parameters for a
cylindrical tube or radius 4.1+0.1cm and length 97+0.1 cm. Standard Deviation (SD).

Kinect Data

Measurement Measured Calculated i Mean

(SD) Difference
Volume [cm’] 49644242 5173 (204) 4927 5550 623 209 cm’
Length [cm] 94.1 +0.1 93.6 (2.0) 97.5 89.8 7.7 -0.5 cm
COM [%] 50% 49.8% (0.9) 523% 482% 4.1% -0.2%
Ixx [kgem?] 3676178 3707 (197) 4049 3449 600 31 kgem®
Iyy [kgem?] 3676178 3702 (196) 4043 3445 598 26 kgem®
Izz [kgem?] 4242 453 (44) 57.9 390 188 3.3 kgem®
4.2 Reliability

4.2.1 Total Volume

Relative precision of the Kinect total body volume estimation was quantified by calculating the
intraclass correlation coefficient (ICC). The ICC for 3 repeated scans across 10 male and 11

female participants was calculated using a two way random effects model and found to be equal
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to ICC (2,1) = 0.966 for the males and ICC=(2,1) = 0.982 for the females indicating very high

reliability.

4.2.2 Segmentation

The repeated measures of segmental volume were evaluated using the ICC coefficient. To
determine the relative repeatability of the segmentation protocol a body scan from each subject
was chosen at random and the segmentation protocol was executed twice. The ICC values were
above ICC (2, 1)>0.70 with the highest values of ICC (2, 1)>0.9 seen for the torso, and leg for

both genders. Full results are shown in Table 18 below.

Table 18: ICC values determined from 2 repeated segmentations of 10 male and 11 female scans.
Both segmentations were done on the same scan.

ICC
Side Segment Male Female
Head 0.92 0.99
Upper
%‘(’)Ic’l‘;r Torso 097 099
Abdomen 0.98 0.99
Pelvis 0.90 0.98
Arm 092 0.81
Right Forearm 0.79 0.75
Hand 093 0.72
Arm 0.72 0.89
Left Forearm 0.72 0.76
Hand 0.86 0.74
Thigh 0.96 0.93
Right Shank 0.97 0.95
Foot 0.93 0.90
Thigh 0.95 0.94
Left  Shank 0.94 0.95
Foot 0.70 0.79
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4.3 Agreement Between methods

A Bland-Altman analysis for the male and female scans reveals the difference between the
Kinect and ECM total volume estimates to be greater than zero in all cases except one (Figure
33). Shown in Table 19 are the summary results of the analysis. The results suggest a fixed
measurement bias of 0.0023m’ (2300 cm®) for the males and 0.0038 m® (3800 cm’) for the
females when scanning with the Kinect. Ordinary least product plots are shown in Appendix E

with the summary of results shown in Table 19 below.
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Figure 33: Bland Altman plot of the difference between the Kinect and ECM estimation
techniques. Males (n=10) are shown in blue and females (n=11) in red. All units are in m’
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Table 19: Summary of results from Bland Altman analysis and ordinary least products
comparing the total volume estimates obatined using the Kinect and the ECM method.

95 % Confidence interval (Bias) Limits of Agreement
[m?] [m?]
Male (n=10) 0.0023  0.0036-0.0012 0-0.0052 0.90
Female (n=11) 0.0038  0.0026-0.0056 0-0.0082 0.93

4.4 Segmental Volume

The volumes for each body segment for the males and females were compared using the

estimated values from the Kinect and ECM acquisition methods. The results for per segment

volumes for male subjects are shown in Figure 34 and the female subjects in Figure 35.

Cumulative volume calculations, which were obtained by adding the volumes of all of the

segments together, show significant differences when comparing the results estimated with ECM

and Kinect for both genders with the Kinect consistently estimating a larger volume than ECM

(Male t (9): 4.84, p<0.001, Females t (10): 5.52, p <0.001). For both genders the largest between

segment differences are seen in the upper torso (Male t (9): 6.63, p<0.001, Female (10),

p<0.001).
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Figure 34: Average volumetric data estimated using Kinect and ECM of 10 body segments for a
male population (n=10). Error bars represent standard error of the population mean.
(***p<0.001, **p<0.01, *p<0.01)
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Figure 35: Average volumetric data estimated using Kinect and ECM of 10 body segments for a

female population (n=10). Error bars represent standard error of the population mean.
(***p<0.001, **p<0.01, *p<0.05)
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4.5 Total Mass

Results show no significant differences exist between mass estimates estimated using ECM and
the scale values for both genders (Male: t (9) = -1.49, p=0.182, Female: t (10) = 2.18, p=0.054).
However, significant differences were observed for the results obtained using the Kinect
(Male: t (9) = 4.62, p<0.01 Female: t (10) = 6.98, p<0.001), with an average overestimation of
2.34 kg for male subjects and 3.88kg for females. ECM showed a slight overestimation on the
mass, with an average of 0.44kg for males and 0.24kg for the females when compared to the
scale values (not significant). Shown in Table 20 and Table 21 are the subject-specific mass

comparison for males and females respectively.

Table 20: A comparison of male mass estimates determined from elliptical cylinder model and
Kinect compared to scale values. Differences between ECM and Scale (ECM-S) and Kinect and
Scale (K-S) are shown. Standard deviation (SD).

ECM-S K-S Difference
Subject Scale [kg] ECM [kg] Difference Kinect [kg]
: (SD)
(SD)
M1 72.90 73.60 0.70 7437 1.47
M2 74 .95 75.40 045 76.86 1.91
M3 79.92 80.82 0.90 83 .40 348
M4 70.95 69.18 -1.77 70.74 -0.21
M5 69.61 69.77 0.16 73.04 343
M6 77.08 78.69 1.61 77.75 0.67
M7 77.88 77.51 -0.37 80.51 2.63
M8 68.72 69.89 1.16 73.48 4.76
M9 75.04 76.07 1.03 79.14 4.11
M10 66.14 66.62 048 67.32 1.17
Average Difference 0.44(0.90) 2.34(1.52)
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Table 21: A comparison of female mass estimates determined from elliptical cylinder model and
Kinect compared to scale values. Differences between ECM and Scale (E-S) and Kinect and
Scale (K-S) are shown. Standard deviation (SD).

. ECM_S . K-S Difference
Subject Scale [kg] ECM [kg] Difference Kinect[kg]

(SD) (SD)
F1 82.77 83.61 0.84 83.65 0.88
F2 79.30 79.24 -0.07 84.34 5.04
F3 63.92 64.07 0.14 65.17 1.25
F4 69.17 70.43 1.26 72.63 3.46
F5 75.04 7481 0.22 80.79 575
F6 68.72 68.33 -0.39 73.96 5.24
F7 61.34 62.73 1.39 64.11 277
F8 68.55 68.00 -0.55 7474 6.20
F9 80.55 81.38 0.83 85.28 4.74
F10 58.50 5923 0.74 63.54 504
F11 64.19 6522 1.03 66.49 2.30

Average Difference 0.45(0.66) 3.88(1.75)

4.5.1 Segmental Mass

Per segment mass estimates obtained using Kinect and ECM were compared to Zatsiorsky and
Seluyanov (1983) regression equations and the published averages from Zatsiorsky and
Seluyanov (1983). Shown in Figure 36 are the results for the males and Figure 37 for the
females. The mass ratios which are the ratio of the segmental mass to the total body mass are

presented in Table 22.
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Figure 36: Average estimated segment mass for male subjects (n=10). Error bars indicate
standard error of the population mean. Regression equations and average values taken from

Zatsiorsky and Seluyanov (1983) are based on an n=100 sample size. (***p<0.001,
**p<0.01,*p<0.05). Head and Neck (H+Neck), Upper Trunk (UpT), Abdomen (Ab).

Looking at Figure 36 the largest differences are seen between the Kinect and the ECM mass
estimation of the upper trunk (t (9) =6.64, p<0.001) and hand (t (9) =5.12, p<0.001). Comparing
the Kinect estimates to the regression values, largest significant differences are seen in the arm (t

(9)=4.21,p<0.01).
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Figure 37: Average estimated segments masses for female subjects (n=10). Error bars show
standard error of the population mean. Regression equations and average values taken from
Zatsiorsky and Seluyanov (1979, 1983) are based on an n=15 sample size. (***p<0.001,
**p<0.01,*p<0.05). Head and Neck (H+Neck), Upper Trunk (UpT), Abdomen (Ab).

More differences between segment mass estimates are seen in Figure 37 for the female data than
the male data. The largest differences are seen between the Kinect estimates in the abdomen
region (t (10) = 6.77, p<0.001), the upper trunk (t (10) =9.55 (ECM), t (10) = 4.60 (Zatsiorsky),

p<0.001) and the thigh (t (10) =2.36 (ECM), p<0.01; t (10) = 5.9 (Zatsiorsky), p<0.001)
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Table 22: Percent total mass shown as the ratio of the average segment mass to the average total
body mass for male (n=10) and females (n=11). SD is shown in brackets. Zatsiorsky and
Seluyanov (1983) average reported values are shown (Zat). No SD provided for females.

Mass [%]
H+N UpT Ab Pelvis Arm FArm Hand Thigh Shank Foot
Kinect 78 159 148 122 3.0 15 0.7 14.7 4.8 15
0.7y (1.2) (1.8) (09) (0.18) (0.18) (0.2) (©.7) (0.6) (0.3
172}
% ECM 77 138 142 121 3.1 1.7 09 14.2 49 1.5
= 0.7) (©.8) (1.7) (©9) (©3) (©2) (@©.1) (©8) (©06) (0.2
Zat 69 159 163 11.2 2.7 1.6 0.6 14.2 4.3 14
0.7y @a.s) a.7) a4 (@©.2) (©.1) (©08 (1.0 (©3) (0.2
Kinect 78 173 9.7 122 28 13 0.6 17.6 5.6 14
g 0s5) 1.7y a10) (13 (©.2) (©3) (02 (d.1) (©.8) (0.3
g ECM 77 148 92 120 29 14 0.7 16.7 5.5 14
= 04) (@.5) ©6) (1.3) (0.2 (@©.1) (©1) @10 (©6) (0.2
Zat 6.7 155 147 125 2.6 14 0.6 14.8 4.8 13

4.6 Principal Moments of Inertia

The principal MOI results for the male estimates collected using Kinect and ECM alongside
estimates using the regression equations from Zatsiorsky and Seluyanov (1983) are shown in

Figure 38. Representative MOI information for females is shown Figure 39.
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Figure 38: Moment of Inertia results along the principal axes of each of the 10 body segments with 1zz representing the longitudinal
axis of the segment, Ixx the anterior-posterior and lyy the medial-lateral. Results shown are for male subjects (n=10) obtained from
Kinect 3D scans, ECM, and Zatsiorsky and Seluyanov (1979, 1983) regression equations. (***p<0.001, **p<0.01,*p<0.05). Standard

deviation shown.
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Figure 39 : Moment of Inertia results along the principal axes of each of the 10 body segments with [zz representing the longitudinal
axis of the segment, Ixx the anterior-posterior and lyy the medial-lateral. Results shown are for female subjects (n=11) obtained from
Kinect 3D scans, ECM, and Zatsiorsky and Seluyanov (1979, 1983) regression equations. (***p<0.001, **p<0.01,*p<0.05). Standard
deviation shown.
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4.7 Anthropometrics

Length and COM location results estimated using the Kinect and ECM were compared to the
average results from Zatsiorsky and Seluyanov (1983). The longitudinal lengths and centers of
mass (displayed as a percentage from the proximal end of the segments over the total segment
length) are presented in Tables 23-25 with accompanying Figures 40-42. Summary data is

shown in Figures 43-46 for the male and female subjects.

Significant differences are seen among many of the segment lengths with the largest observed
differences at the hand (M: t (9)=7.4; F: t (10)=9.4, p<0.001) and foot (M: t (9)=8.3; F: t
(10)=3.9, p<0.001) for both genders. Differences in the COM for the males and females of the
pelvis show the largest difference between the ECM and Kinect with the COM overestimated by

15% for the males and 9% for the females (M: t (9)=8.8 F: t (10)=5.2, p<0.001).

90



Length Hand Length Forearm Length Arm

Centroid

Centroid

3rd Met .‘:—‘“

%COM

i 1
i i
] i
! i 1 TR
H SSesthit e <
i i
i 1
i 1
i 1

%COM

Figure 40: Body arm segmentation showing centre of mass (Centroid), proximal distance of
COM as a percentage of the total longitudinal length of the segment (%COM) and longitudinal
length of segment (Length). Estimates of the third metatarsal (3" Met), Wrist joint center (WJC),
Elbow joint centre (EJC), and Shoulder joint center (SJC) define the estimated endpoints of each
segment.

Table 23: Male and Female longitudinal segment length data and %COM from proximal
endpoints for the Arm, Forearm and Hand obtained using the Kinect and ECM. Average values
(Avg) published by (Paolo de Leva, 1996) based on (Zatsiorsky & Seluyanov, 1983) subjects.
Standard deviation shown in brackets.

Arm Forearm Hand Arm Forearm Hand

2912 2601 1529 Kineet 2909 2472 1477
Kinect (1839) (107) (202) (174) (213) (175)
2828 2738  199.7 2674 2614  189.7
Length [mm)]

ECM 7.0 115 (120) ECM (24.5)  (187)  (10.4)
Avg. 28L7 2689 1879 Avg. 2751 2643  170.1

o =

(2]

2 5
415 418 418 Kineet 304 43.0 43.1
Kinect (16) (10) (23) meet as a9 @4
COM 38.5 429 40.7 ECM 41.4 43.9 40.6
[%] ECM (25 (1.5) (2.3) (3.3) (2.4) (3.9)
Avg. 5717 45.7 36.3 Avg. 575 45.6 342
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Table 24: Male and Female longitudinal segment length data and %COM for the Head+Neck
(H+N), Upper Trunk (UpT), Abdomen (Ab) and Pelvis obtained using the Kinect and ECM.
Average values based on (Zatsiorsky & Seluyanov, 1983). Standard deviation shown in brackets.

H+N  UpT Ab  Pelvis H+N  UpT .\ Pelvis
2623 2478 1954 224.1 2642 2737 1315 2242
Kinect (10.1) (17.7) (18.7) (15.3) (15.5) (407) (11.3) (172)
Length 2888 2377 2046 187.6 2843 2727 1588 2142
[mm] ECM  87) (155 (19.7) (164) (133) (26.1) (432) (22.0)
Avg 2429 2421 2155 2517 2437 228 205.3 %
%)
= =
§ £
<P]
494 544 487 370 ==  48.1 55.7 49.6 36.6
Kinect 07y (13) «d.1) (1.7 (13)  (2.6) (1.1) (1.1)
COM 465 588 512 508 455 566 486 458
[%] ECM (1.1) @6) (15 (34 (1.8) (1.8) (8.8) (5.9)
Avg 500 506 450 354 48.5 50.5 45.1 %

* Data not provided in comparable reference length due to differing endpoints
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Figure 42: Leg body segments showing centre of
mass (Centroid), proximal distance of COM as a
percentage of the total longitudinal length of the
segment (%COM) and longitudinal length of
segment (Length). Estimated Hip joint center
(HJC), Knee joint center (KJC), and Ankle joint
center (AJC) are shown.

Table 25: Male and Female longitudinal segment length datum and %COM for the Thigh, Shank
and Foot obtained using the Kinect and ECM method. Average values adjusted by (Paolo de
Leva, 1996) based on (Zatsiorsky, V. & Seluyanov, 1983) except the foot which was not
adjusted. Standard deviation shown in brackets.

Thigh Shank Foot* Thigh  Shank Foot
Kineet 4972 4063 2463 477.1 3863 230.0
(174)  (163)  (10.6) (26.5) 234)  (19.2)
Length [mm] ey V55 4150 2227 4262 4042 2158
(325) (188) (3.5 (34.0) 288)  (12.0)
Avg 4222 4403 2581 368.5 438.6 2283
v —
e <
<
< g
Kineet | 134 405 435 = 444 409 434
e (1.0 (1.3) (2.8) (1.1 0.9) (2.3)
COM 44.7 40.0 39.1 38.2 41.2 38.2
[%] ECM (3.3) (1.8) (2.4) (4.6) (1.3) (2.0)
Avg 41.0 44.0 44.2 36.1 435 40.1
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Figure 43 : Summary of longitudinal segment length for males comparing estimations obtained
using Kinect, ECM and those reported in Zatsiorsky and Seluyanov (1983) Error bars report

standard deviation. (***p<0.001, **p<0.01,*p<0.05)
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Figure 44: Summary of %COM from proximal endpoint for males comparing estimations

obtained using Kinect, ECM and those reported in Zatsiorsky and Seluyanov (1983). Error bars

report standard deviation. (***p<0.001, **p<0.01,*p<0.05).
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Figure 45: Summary of longitudinal segment length (mm) for females comparing estimations
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Figure 46: Summary of %COM from proximal endpoint for females comparing estimations
report standard deviation. (***p<0.001, **p<0.01,*p<0.05)
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4.8 Comparisons of Body Sides

Manual segmentation of the point cloud data resulted in differences seen between opposing
segments (left and right). Presented in Table 26 are the average absolute differences between the
left and right side segments for males and females for the following estimates: volume, principal
MOI (in directions Ixx, lyy, and Izz), segment length and % COM from proximal endpoint.
Large volume differences are seen between sides for the hand (Female= 29.1 % (37.8%), Male=
36.7 % (27.4%)). The large observed standard deviations show that there is a huge spread in this
data. The forearm shows the second highest differences between sides (Female = 14 %( 15.3%),
Male = 14.2 % (8.9%)). Small differences are seen with the thigh, shank and arm with

differences of less than 7%.

The MOI results show the highest differences in all three directions for the hand, forearm and
foot for both genders. Segment length estimates show low differences (<5%) for all segments
except the hand (Female = 9.3 %( 9.1%), Male = 11.5 %( 9.8%)). Finally, % COM estimates
show low differences again (<5%) with the highest variability once again in the hand
(Female = 3.7 %(2.5%), Male = 4.4 %( 3.3%). A summary of the raw data estimated using the

Kinect and ECM methods is provided for in Appendix G.
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Table 26: Average absolute differences of left and right side segments for male (n=10) and
female (n=11) of estimated BSIP’s. Standard deviation is shown in brackets.

Body Segment
Arm Forearm Hand Thigh Shank Foot
Volume Female 4.7 % 14.0% 29.1% 4.1% 6.3% 10.2%
(4.7%) (15.3%) (37.8%) (2.2%) (5.3%) (8.8)
Male 6.5% 14.2% 36.7% 3.1% 4.0 % 6.1%
(4.6%) (8.9%) (27.4%) (2.7%) (2.7%) (4.9%)
Ixx Female 8.4% 22.7% 46.1% 4.0% 8.5% 21.3%
(4.4%) (20.1%) (46.9%) (2.5%) (6.3%) (20.6%)
Male 9.6 % 15.7% 64.4% 8.2% 7.7% 10.9%
(5.9%) (7.3%) (45.1%) (6.4%) (4.8%) (9.5%)
Iyy Female 15.4% 23.4% 46.2% 4.6 % 9.0% 21.0%
(11.1%) (24.8%) (48.6%) (2.9%) (7.0%) (12.0%)
Male 8.47% 14.61% 53.8% 8.04% 6.25% 14.65%
(6.2%) (8.3%) (42.8%) (5.7%) (4.6%) (10.3%)
Izz Female 9.5% 23.9% 44.7 % 7.3% 13.3% 20.0%
(4.9%) (20.9%) (50.2%) (3.6%) (11.5%) (12.6%)
Male 18.7% 24.9% 48.6 % 7.3% 9.5% 13.3%
(15.4%) (20.9%) (34.6%) (6.4%) (6.6%) (8.5%)
Length Female 2.8% 2.6% 9.3% 0.8% 1.6% 4.1%
(1.9%) (2.8%) (9.1%) (0.5%) (0.9%) (2.9%)
Male 1.9% 2.3% 11.5% 1.9% 1.9% 32%
(1.4%) (1.7%) (9.8%) (0.6%) (1.4%) (2.7%)
COM Female 2.4% 31% 3.7% 13% 11% 32%
(1.7%) (2.5%) (2.5%) (0.8%) (0.8%) (3.8%)
Male 2.5% 1.9% 4.4% 1% 11% 2.6%
(2.2%) (1.1%) (3.3%) (0.6%) (0.9%) (2.2%)
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Chapter 5
Discussion

5.0 Introduction

As a primary goal, this experiment sought to investigate whether the 3D data attained
using the Microsoft Kinect V2 could be used to estimate subject specific BSIPs. Ten male and 11
female subjects were recruited from the Queen’s University student population. Each subject had
three full body 3D scans taken using a developed protocol. Each full body scan was manually
segmented in Meshlab into 16 segments according to the segmentation protocol of Zatsiorsky
and Seluyanov (1983). Data from the body segmentation process were imported into custom
MATLAB code, which quantified the resultant BSIP outputs. Also using ECM, developed by
Jensen (1978), BSIPs were determined with this subject specific geometric method. The output
BSIPs obtained using the Kinect V2 protocol was compared to those from the ECM. Data
obtained using Zatsiorsky and Seluyanov (1983) regression equation, which used subject height
and mass as input parameters, was compared to the values estimated using the Kinect and ECM
methods. This specific set of regression equations was chosen as they were developed using
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medical imaging technology with a large subject pool that closely resembled that of this study

(Zatsiorsky & Seluyanov, 1983; Zatsiorsky, 2002).

5.1 Comparison of Results

5.1.1 Total Body and Segment Volume

The total body volume estimates were consistent among repeated scans (3 scans per person) with
male and female results showing ICC (2, 1) = 0.95. Results estimated using the Kinect were on
average 0.0023 m’ (3%) and 0.0038m’ (5.1%) higher for males and females respectively when
compared to ECM volumetric estimates. The overestimation is consistent with the findings from
scanning the cylindrical object, where the Kinect overestimated total volume by approximately
4.2%. The Bland-Altman analysis suggests a fixed measurement bias. All but one case shows the
differences were above zero as seen in Figure 33. There is no evidence of any proportional bias

suggesting larger volume does not mean larger difference.

In the study by Clarkson et al. (2014) 12 male torsos were scanned and segmented. The author
observed a systematic measurement offset of 0.001 m’ when comparing to the volumes predicted
using Yeadon’s (1990) geometric model. Clarkson et al. (2014) used an older version of the
Kinect device (Version 1), which has a lower depth resolution than the Kinect V2 (Clarkson et
al., 2014; Microsoft Corporation, 2015). However, the observations were similar as to those
observed in this experiment. The Kinect overestimated the upper torso by approximately
0.0019m’> and 0.002 m’ for males and females respectively. The upper torso volume
overestimation accounted for 83% of the volume overestimation seen in the total volume of the

males and 53% for the females.
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The accuracy results of the Kinect V2 from Yang et al. (2015) suggest that based on the distance
away the subject was during this experimental protocol, the average depth accuracy error would
be around 2mm (Yang et al., 2015). For a scanning volume of Im’ (as an example) this would
equate to a scanning error of approximately 0.006m’ or about 0.6%. The total scanning volume
for the subjects was much lower; therefore, the overestimation cannot be fully attributed by the

device measurement errors suggested by Yang et al. (2015).

Concave surfaces and high radius edges (of 90° and greater) have shown to be problematic with
the older generation Kinect V1 and are a known issue with many other 3D scanning technologies
(Meister et al., 2012). The scanning of concave surfaces or steep edges on the body can result in
volume inaccuracies. Although subjects were asked to keep their hands extended during
scanning (to prevent cupping) it would appear that the hand/palm region was not estimated in
high detail during the scans. Similar observations were seen for the head/ neck region as well as
in-between the thighs and under the arms (regions of steep edges). Examples of the head and

hands is shown in Figure 47 showing select scans of varying degree of deformity.
»

Figure 47: Head and hand scans. Varying degree of detail in the head region with concave
surfaces appeared as filled in. Further to the right head suggests subject sway, as facial features
are distorted.
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Per segment volume results (Figure 34 and Figure 35) suggest that there is the largest significant
difference in the estimation of the volume of the upper torso, for both genders (Male t (9): 6.6,
p<0.001, Female: t (10) = 9.1, p<0.001)). This was consistent amongst all of the segmented
torsos for males and females. The experiment was designed to limit any error associated with
data collection but the manual nature of segmentation performed in the ECM and the 3D
segmentation protocol is a factor, which cannot be disregarded. The segmentation of the trunk
region required proximal and distal as well as lateral and medial cuts, making the upper trunk
section cumbersome to segment. Although every precaution was taken to keep segmentation
error to a minimum, errors resulting from the digitization of the trunk (ECM) and planar
segmentation of the 3D scans (performed in Meshlab) could explain some of the observed

differences. A close up of the segmentation of the torso is shown in Figure 48.

Figure 48: Left: Digitization of the trunk region Right: Planar segmentation of trunk region

Other possibilities for a larger observed volume could be attributed to the scanning posture. In
the ECM protocol subjects stood with their arms closer to the body, whereas in the Kinect

protocol the subjects had their arms abducted approximately 90°. The modified pose for the
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Kinect was to minimize scanning errors that were observed when the subject had their arms too
close to the trunk (Figure 16). The pose could have contributed to a larger observed volume in
the scans of the torso. From the 3D scans it appears that this pose extended the chest muscles
resulting in the possibility that a larger volume was attributed to upper torso during
segmentation. This would mean that the arms would lose volume. In both genders the arms were,
on average, estimated to be lower in volume with the Kinect. The torso is highly sensitive to any
chest movement resulting from breathing. If the subjects chest was moving during the scanning
this could have also attributed to the observed volume discrepancies. In the protocol subjects

were asked to take only very shallow breaths during the scanning to minimize this effect.

Deviations from the contours of the body in digitization with ECM could account for errors of
volumetric data attained with ECM (Wicke & Lopers, 2003). However, variability was
minimized as a single trained operator performed the digitization over 50 times. Wicke and
Lopers (2003) stressed the importance of ensuring that the participant was properly aligned with
the camera axes during the photo acquisition portion of ECM. Although this was highly enforced
in the data collection sessions, slight movement during collection was possible. Wicke and
Lopers (2003) commented that the general overestimation seen in the ECM method may have
been due to cavities in the shapes of the hand, chest and head (Wicke & Lopers, 2003). Cavities
in these regions could have perhaps been less pronounced with the ECM method but picked up

with the Kinect, resulting in volume discrepancy.

Additionally, motion artifact during 3D scanning may have contributed to unwanted 3D points,
which could result in a discrepancy in the total volume. Although visual inspection made it
possible to see when a subject had moved (example: large swaying of the arms resulted in

obvious deformations in the scan as shown in Appendix F), it was very difficult to see small
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movements. Movements could have contributed to extra points in the cloud resulting in volume
overestimation (such as Figure 47, furthest right images). The head scans shown in Figure 47
demonstrate how a slight movement of the head would appear in the scan. Meunier et al. (2000)
scanned the heads of subjects with a 3D laser scanner and noted that involuntary movement was
unavoidable but could be mitigated with a head rest (Meunier et al., 2000). Goktruk et al. (2004)
noticed that the motion artifact in scanning simple objects was mostly observed around the edges
of the objects. He proposed an increase in frame rate would minimize the problem (Gokturk et
al., 2004). In this protocol the scanning frequency of 30Hz was at the maximum range capability
of the Kinect V2 (Microsoft Corporation, 2015). The scan duration of approximately 30 seconds
in this experiment is long and standing with your arms raised for this amount of time will almost
certainly lead to small vibrations of the body, making this a major limitation. If this pose is to be
adapted, allowing support for the arms perhaps by using a string hanging from the ceiling could

minimize involuntary movement of the limb.

5.1.2 Mass

The scale mass values provide the closest approximation to the true mass of the subjects. The
estimates obtained with ECM show an average body mass overestimation of 0.44kg for the
males and 0.45 kg for the females, corresponding to an average error of (M:0. 59%, F:0.64%)
when comparing to the scale. The Kinect overestimated mass by 2.34kg for males and 3.88 kg on
average for females, corresponding to an average error of (M: 3.11%, F: 5.23%). There appears
to be a wide range in mass estimation with Kinect differences ranging from -0.21->4.76kg

(Males SD: 1.52) and 0.882>6.20kg (females SD: 1.75) (Table 20 & Table 21). It appears as if
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the over/under estimations are random. No correlation between the subjects BMI values, weight,

or height is seen when investigating these differences (Appendix F).

The larger discrepancies seen in the female subjects suggest that morphological differences play
a role. The thigh, pelvis and upper trunk for the females were estimated to be of larger volume
using the Kinect, compared to ECM estimates in turn leading to larger mass predictions. This
could have been a result of the breasts and larger hips. The abdomen region for the females
shows no significant differences between Kinect and ECM methods however a large average
difference is seen when comparing to the regression equation results. It is possible that this is a
result of the 12% larger BMI in the female subject pool in this experiment when compared to
that of the pool of which the regression equation are based on. The segment mass means
compared well for the males across all of the methods (6.4% higher BMI when compared to
regression subject pool). On average the per segment results compare well with the Kinect
acquired data showing segment mass averages which are also quite similar to the regression
equation results. The segmental mass values shown as a percentage of the total weight (Table 22)

show trends similar to those mentioned above.

The mass estimates in this experiment were based on density inputs derived from cadavers of a
much older population (Chandler et al., 1975) and from CT trunk estimates of a more closely
related population (Pearsall et al., 1996). Using a surface scanning technique such as the one
proposed here, there is a large amount of versatility with the inputs. For example, Rossi et al.
(2013) captured 3D scans of subjects using an Artec 3D Scanner (V0.6) (Price: $5-20k) and with
subject specific DEXA scans derived density inputs which were inputted into the 3D scans
(Rossi & Lyttle, 2013). The possibility of substituting a highly expensive not widely available

camera like the Artec with the Kinect appears promising. Alternatively, carefully selecting
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density values to appropriately match the criteria of the subjects being measured from literature

is possible reducing the need for expensive medical imaging.

5.1.3 Mass Moments of Inertia

The estimated principal MOI from the 3D scans show measurement means that are comparable
to those estimated with ECM and those estimated using the regression equations from Zatsiorsky
and Seluyanov (1983). The largest mean differences seen in the Kinect data were in all three
principal MOI for the upper torso of the males and females. This was not surprising as this part
of the trunk had already shown to be overestimated in volume and consequently, had a larger
mass. Calculating the MOI can be challenging to obtain accurately due to the squaring of the
moment arm (Wicke & Dumas, 2014). The experimental results observed in this experiment
show comparable means for the MOI across the three methods of acquisition. This suggests that

the findings show potential.

The Kinect scans deliver consistent outputs amongst repeated scans (25 scans) without visible
deviations. From scanning the cylinder, a volume overestimation of 209 cm’ (4.2%) with a
standard deviation of 204 cm’, was observed which resulted in less than 1% error in calculating
the MOI about the Ixx and lyy axis of the cylinder (coordinate system show in Appendix C). A
7% error was seen in the MOI about the longitudinal (Izz axis). This suggests that the scans were
accurately portraying the physical geometry but with a larger radius than measured. This would
result in estimating a larger total volume and in turn the MOI about the longitudinal axis Izz
would also be larger, as observed. Although larger volumes were observed with scanning the

body, this likely did not have a larger effect on the MOI values presented here. The results
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suggest that overestimation would be spread evenly (every point slightly overestimated), which

would have a small effect on the MOI.

In early studies, only Chandler et al. (1975) presented the MOI data along the principal axes of
the body segments. The technique involved supporting each cadaver segment rigidly in a specific
orientation and estimating the MOI about several axes during rotation (Chandler et al., 1975).
This allowed for computation of the principal axes and an estimation of the inertial tensor.
However, the data has been disputed and deemed incorrect as the findings did not satisfy the

inequality depicted by Equation 8 (Zatsiorsky 2002).

Ly + Ly = Iy

Equation 8: Principal MOI inequality equation. Where Izz is the longitudinal axis lyy is the
medial lateral axis and Ixx is the anteroposterior axis

The MOI data presented in this experiment satisfies the inequity. With the computerized nature
of the project it is simple to evaluate this. A major advantage of the MOI estimates taken from
3D scans is that they are highly adjustable. There is a large amount of versatility because the data
is programmable. Therefore, the morphology of the subject does not limit the possible outputs.
Studies which used cadavers or living body segments (quick release method) are difficult to
manipulate once the data is collected, because the collection is highly dependent on the specimen
available (examples: (Chandler et al., 1975; Dempster, 1955)). With medical imaging such as
DEXA, the MOI is restricted to two planes, limiting the output estimates (Wicke & Dumas,
2008). With the MOI being highly dependent on the orientation, morphology and mass,

reporting in various coordinate systems and orientations of the body would not be difficult with
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this technique. This suggests potential of the Kinect in future applications, which require MOI

estimates.

5.1.4 Segment Length and Center of Mass

The digitization and segmentation were done separately for both methods and could explain
some of the mean differences (<5%) seen in the segment lengths. Using ECM, Sanders et al.
found a variability of <5% for the longitudinal segment except for the neck (5.2%) (Sanders et
al. 2015) Differences in the length of the hand (+25%) with the Kinect (M: t (9) =7.43, p>0.001,
F: t(9) =9.39, p>0.001) may be a result of poor scanning quality of the 3D point cloud (as shown
in Figure 47) resulting in possibly a weak definition of the longitudinal vector. There were no
observed statistical differences (p>0.05) in the longitudinal length of the upper trunk, abdomen,
arm, and thigh for the males and the upper trunk for the females. Differences between ECM and
Kinect may be attributed to the definitions of the segment endpoints. In ECM anatomical
landmarks placed by the operator are manually selected in the Slicer software to define segment
endpoints. In the Kinect the longitudinal vector is defined as the inertial axis of each segment
(Figures 30-32 show all of the coordinate systems). The length of the vector is based on the
proximal and distal intersection of this axis for each segment (passing through the centroid).
Although the developed protocol was only a proposed approximation of the segment endpoints,
the results validate the method, as the means across both genders do not suggest large

differences.

Slight deviations of the location of the joint centers could easily contribute to differences seen in
the COM estimates. There was good agreement between Kinect and ECM with differences

between methods of fewer than 2% except for the pelvis. The pelvis COM was estimated to be
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higher with the ECM by approximately 15% for the males and 9.1% for the females. The lower
pelvis length seen with the ECM model suggests that the pelvis length is estimated from the
Omphalion to an estimated hip joint centre, whereas in the Kinect protocol this length is from the
Omphalion to the pubis. This could however not be verified but the results suggest it to be the
case. Although differences are seen for the COM estimates between methods, the results validate
that the proposed protocol can estimate the COM of the body segments. With further work this

can be further verified and improved upon.

5.2 Segmentation

Segmentation of the 3D scans showed ICC estimates for the segment volumes across two
separate segmentations of a single scan to be on average ICC (2,1) =0.80 with the foot, arm,
forearm and hand showing the lowest values (Male: ICC (2,1) = 0.70 (foot), ICC (2,1) = 0.72
(Forearm and Arm), Female: ICC (2,1) = 0.79 (Foot), ICC (2,1) = 0.74, 0.72 (Left-hand, Right-
hand))). The values indicate a high repeatability with ICC = 0.70 considered as adequate (de Vet
et al., 2006). The lower ICC values for the foot and arms could be due to the distortion of the
anatomical landmark markers present in these regions. The landmarks, which were
approximately 2cm in diameter, had a high contrast between the subject and their skin, which
acted as segmentation boundaries. Unclear landmarks on the scan could have resulted in less
accurate segmentation repeatability. Although tape was used to better define the segmentation
boundaries (detailed in Methods 3.1.1), this also was not always clear, as shown in Figure 51.
Color scanning requirements, which helped to define the landmarks, is a limitation in the
segmentation method of this experiment because the segmentation fully depended on clear color

scans.
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Another limitation is the scan alignment. Each body scan prior to segmentation was aligned so
that the body was positioned along anatomical planes. This was done by aligning the scan about
a principal axes (as detailed in the Methods 3.2.3). Segmentations cuts were made about a plane
perpendicular to this orientation. Therefore, any misalignment of the scan would result in the
perpendicular cut being angled, with the possibility of the segment being sliced on a slant. This

would inadvertently affect the inertial estimates.

The time required in post processing is largely due to the segmentation protocol. Each 3D scan
took about 45min-1 hour to manually segment following the developed protocol. This suggests
the potential for developing a quicker segmentation protocol alongside dedicated segmentation
software. One future approach to this could be using the Kinect V2 Skeleton available with the
Kinect. This approach could eliminate the land marking reducing the subject interaction time
and post processing time (Microsoft Corporation, 2015). Eliminating the manual anatomical land

marking and manual segmentation would make it possible for the system to be fully automated.

The Kinect V2 skeleton is capable of estimating up to 25 joints (Microsoft Corporation, 2015).
The major difficulty would be in simultaneously capturing the skeleton and the 3D data then
overlaying them onto each other (Skeleton and 3D data are in different coordinate systems). A
suggested approach to this is shown in Figure 49-50. However, the accuracy of using the Kinect
V2 Skeleton in estimating joints which are subject specific has yet to be evaluated in literature.

Based on preliminary testing, the capabilities are promising but work still needs to be done.
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Figure 49: A: Kinect Skeleton imported into Matlab. B: 3D scans of test manikin. C.
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Figure 50: Flow Chart of proposed future segmentation protocol and proposed questions
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5.3 Scanning

A major drawback of the scanning protocol was circling the Kinect around the subject. Due to
the orientation of the subject (with the arms abducted at 90° to the torso), the Kinect device
would come significantly closer to the subject’s hands than any other body part (Figure 52-A). It
is possible that this could have contributed to errors and explains some of the poor quality scans
of the hands (shown in Figure 47). If a subjects arm span was at or above 1 meter then this would
mean the Kinect would be viewing the subject’s arms at a distance that it reportedly cannot track
(Lachat et al., 2015; Microsoft Corporation, 2015; Yang et al., 2015). The exact implications of
this are not known. However, as can be seen in Figure 51 it would appear that this could
contribute to the consistent discoloration seen along the arms of the subject resulting in loss of

landmarks.

111



Figure 51: Scans of subjects showing arm discoloration and potential inaccuracies as a result of
physical Kinect distance or subject movement.

Figure 52 provides an example of adjusting the subject’s arms to optimize the Kinect viewing
distance. Alternatively, a larger radius within the area of lowest error (Figure 12) could be used
to encircle the subject (Yang et al., 2015). However, due to the limitations imposed by the
physical room this experiment took place, this was not possible. As seen in Figure 53, by
bending the arm at the elbow and keeping the hands extended and forearms internally rotated it is

hypothesized this could minimize the scanning error by increasing the scanning distance.
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Figure 52: A: The current experimental setup with subject’s arms abducted 90 away from torso.
The Radius (r) which was 1.5m significantly decrease when the Kinect is near the hands. B.
Suggested modified pose to increase radius.

It is possible that the scanning protocol also resulted in the differences seen amongst the both
sides of the body (right side versus left side) for the body segments. These differences were
highest for the hands and forearms. With the distortion seen from the discoloration poorer
visibility of the landmarks also lead to lower repeatability in the segmentation further explaining

the results.

5.4 Advantages and Limitations of the Method

The proposed experimental setup is low cost (~$300), simple to use and widely available. As
shown, the system is capable of estimating a variety of BSIPs and anthropometric measures,
which are specific to the subject of interest. This allows for the measurements to be specific to
the subject and not reliant on any prior assumptions on the geometry of the body. In addition,
there is the possibility of obtaining data such as segment circumferences even when the subject

has already left the data collection. 3D body scans provide the flexibility of archiving the scans if
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future subject information needs to be quantified. Another noteworthy advantage of the system is
the ease of use, as there is only limited training required. Methods which are subject specific

methods can require skilled technicians (Hatze 1980; Yeadon 1990).

The dedicated MATLAB code served as a means of rapidly calculating the desired outputs.
However, Meshlab, which is open-source, and freely available software, is capable of estimating
all of the parameters, which were estimated in this experiment. If a researcher desires only a
couple of measures from a small number of subjects it is definitely possible to acquire volume
and MOI parameters from Meshlab (Peyer et al., 2015; Shin et al., 2013). This could keep the
associated costs quite low and allow the setup to be very feasible for a wide range of laboratories

without excessive programing requirements or high setup times.

The Kinect appears to overestimate volume but almost entirely in the trunk. Further studies
should investigate different body types and see if these observations are consistent. Yang et al
(2015) proposed techniques to increase the accuracy of the Kinect by using multiple sensors
however, further investigation into the hardware technology of the Kinect V2 has yet to be

carried out (Yang et al., 2015).

The findings in this experiment suggest that the Kinect V2 setup could be used to acquire BSIP
information of subjects without restrictions. Subjects such as: children, high/low BMI subjects,
pregnant woman, and amputees to name a few could be better represented by using the proposed
setup. Applying generalized models to these populations is not representative and could affect
experimental outcomes (Kwon 1996; Pataky et al., 2003). Damavandi et al. (2009) showed that
subject morphology is directly related to changes in MOI estimates (Damavandi et al., 2009).
Challis and Kerwin (1996) showed joint moments are sensitive to the COM estimation. The

limitation however is the density values. This method only acquires the morphological surface
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information and not the internal compositions of the body. Therefore, density inputs should be

selected based on similar populations for highest accuracy.

The current space requirements suggest a room size of 4mx4m to comfortably carry out the
protocol. Although this is not a lot of space it can be a limitation in labs with limited space.
Rotating the subject and having the Kinect stationary is a possibility, which was only
experimented with to a minor extent. This could be something, which can be invested for further
study. Secondly, the posture proposed in this protocol could be difficult for children or patients
who are unable to remain still for a longer period of time. In such cases, modifications can easily
be made. Researchers wishing for solving BSIPs of only certain segments of the body can

develop a modified protocol by simply scanning the segments, which are of interest.
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Chapter 6

Conclusions and
Recommendations

6.0 Conclusion

The first objective of the project was to determine if it was possible to acquire subject specific
BSIP estimates using a Kinect V2 and if so to develop a protocol. A 3D scanning protocol was
designed using the Microsoft Kinect V2 as the main acquisition tool. Ten male and 11 female
subjects were recruited from the Queen’s University student population. Each subject had three
full body 3D scans taken following a developed protocol. The protocol used freely available
software. 3D Builder, Microsoft’s 3D acquisition tool designed for the Kinect V2, was used as
the interface to capture point cloud data. Meshlab and Netfabb Basic were used to manipulate,
triangulate the points and segment the subject appropriately. Custom written Matlab code, was
used to approximate the volume, mass, MOI, COM and longitudinal segment lengths of each of

116



the body segments. Although it was possible to calculate these this manually in Meshlab, using
Matlab the process could be automated and the outputs better tailored. The volumetric results

obtained with the Kinect were consistent among 3 repeated scans (ICC (2, 1) =0.95).

The second objective was to make comparisons between the estimates obtained using the Kinect
V2 system to those obtained with a geometrical model which has been validated in literature
Results were compared to predicted values from the ECM (elliptical cylinder model), a
geometrical model developed by Jensen (Jensen 1978). The Kinect overestimated total volume
on average by 0.0023 m® (3%) and 0.0038m’ (5.1%) for males and females respectively when
compared to ECM volumetric estimates. This would appear as a systematic bias because static
scanning of a measured cylinder showed volume overestimation of approximately 4.3%.
However, the overestimation could be attributed to a variety of factors. Movement of the subject
during the scanning protocol, physical distance of the Kinect and the manual segmentation are all

factors that may contribute to error in the total segmental volumes.

Total body mass was overestimated on average 2.34 kg for male subjects and 3.88kg for females
using the Kinect. ECM showed a slight overestimation on the mass, with an average of 0.44kg
for males and 0.24kg. The MOI values across all three estimation techniques were comparable
with largest differences seen in the upper torso region. Similar observations were seen for the

longitudinal length measures.

The final objective of the project was to conclude on the finding with respect to the value of this
device in this field of research. The results suggest great potential for a low cost system (~$300)
for acquiring subject specific BSIPs. Without gold standard data it is difficult to conclude
whether the observed differences were systematic however the findings show similar results too

two other methods performed in this experiment. Although those methods have their own
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attributed errors it is promising to see comparable results across all of the BSIP parameters for

this specific subject pool. The potential of using the device on subjects of varying morphology

and age still needs to be investigated but there is no reason to suggest that the errors would

substantially differ from what was observed in this experiment. .

Considering these factors, the Kinect offers the potential of acquiring a wide range of subject

segment information at a very low cost. There is flexibility with the segmentation definitions and

density inputs, allowing for highly tailored BSIP calculations of subjects of interest. The results

suggest that the device would be well accepted in this field.

6.2 Future Recommendations

1.

It is proposed to use the Kinect Skeleton V2 to automate the manual segmentation
protocol presented in this experiment. By simultaneously capturing the skeleton
alongside 3D data one could overlay the data and use the Skeleton joint estimations as the
regions of planar segmentation. The Skeleton would need to be further evaluated as to the
accuracy of estimating subject specific joint estimates. This could be done by comparing
the results obtained from manual land marking to those estimated with the Skeleton.

The scanning posture could be modified to reduce the chance of movement during
scanning protocol and increase the distance at which the Kinect device is when scanning
the arms. This could potentially lead to improved results of the hand and forearm region.
Changing the posture could also lead to reducing the chance of subject sway; in turn
increasing the quality of the outputs. Reducing sway could also lead to increased view of

the anatomical landmarks used for segmentation in the arms.
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The use of multiple Kinect V2 devices could be investigated to reduce the data
acquisition time, minimizing any chance of subject movement. Using multiple devices
could also lead to a fully automated system requiring only a single computer operator. If
the cameras were position in such a way that they could capture the features of the

subject in 360°, this would reduce acquisition time sensationally.
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A.1 Queen’s University Ethics Approval
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Room 319, McLaughlin Hall

130 Stuart Street

Kingston, ON, K7L 3N6
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Title: "GMECH-033-15 Estimating Body Inertial Parameters Using Microsoft Kinet"

Dear Mr. Kudza:

The General Research Ethics Board (GREB), by means of a delegated board review, has cleared your proposal
entitled "GMECH-033-15 Estimating Body Inertial Parameters Using Microsoft Kinet" for ethical compliance
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occur in the next year.
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occur during this one year period (access this form at hitps://eservices queensu ca'romeo_researcher/ and click
Events - GREB Adverse Event Report). An adverse event includes. but is not limited to, a conpplaint, a change or
unexpected event that alters the level of risk for the researcher or participants or situation that requires a substantial
%ﬁ%ﬁm a participant(s). You are also advised that all adverse events must be reported to the GREB
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You are also reminded that all changes that might affect human participants must be cleared by the GREB. For
example you must report changes to the level of risk, applicant charactenstics, and implementation of new
procedures. To make an amendment, access the application at https://eservices.queensu. ca’romeo_researcher/ and
click Events - GREB Amendment to Approved Study Form These changes will automatically be sent to the Ethics
Coordinator, Gail Irving, at the Office of Research Services or irvingg/@queensu ca for further review and clearance
by the GREB or GREB Chair.

On behalf of the General Research Ethics Board. I wish you continued success in your research.
Yours sincerely,

e

Joan Stevenson, Ph.D.
Chair
General Research Ethics Board

c Dr. Genevieve Dumas, Faculty Supervisor
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A.2 Letter of Information and Consent Form

Project title: Estimating Body Segment Inertial Parameters using a Microsoft Kinect

Researchers: Pawel Kudzia B.Eng , Genevieve Dumas PhD

Background information: You are being invited to participate in a research study directed by
Mr. Pawel Kudzia and overseen by Dr. Geneviéve Dumas as part of Mr. Kudzia’s Master’s
thesis to evaluate the feasibility in using a Kinect in estimating morphological parameters of the
body. These parameters are necessary in biomechanics specially in estimating loads on joints.
We will read through this consent form with you in order to describe procedures in detail and
answer any questions you might have. This study is funded by the NSERC Discovery Grant
program and has been reviewed for ethical compliance by the Queen’s University General
Research Ethics Board.

Details of the study:

Purpose: The aim of this study is to evaluate the feasibility and practicality of using a Kinect
camera to capture morphological features of the body. Specifically, by using a Kinect, the
manual measurement aspects of other methods could be reduced. By reducing manual input in
body model, the participant interaction time could be reduced, error can be minimized, and the
technical status within the field of anthropometrics and biomechanical analysis can be advanced.

Commitment: Your participation in the current study will consist of a one-hour session in
which information regarding the morphology of your body will be captured. Anatomical markers
(reflective tape) will be placed on bony landmarks of your body to help the researcher identify
these important features in the post processing stage of the experiment. Identification of
anatomical landmarks will require the researcher to palpate various locations on your body some
of which include: the spine, arms, shoulder and hipbones. You have been asked to wear tight and
forming clothing as a means of reducing errors associated with measurement and marker
placement. Specifically, male volunteers will have the option to wear forming shorts and either a
tight forming shirt or no shirt at all. Female volunteers will be given the option between wearing
long or short forming pants and a sports bra or a tight forming workout shirt. Each subject will
have their weight taken and their height measured and a few other body measurements.

Once the markers have been placed on you, you will be asked to stand in a designated area of the
room with your palms open facing forward. When ready, the researcher will do a quick count
down and ask you to stand still for about 3 seconds. Two photographs, snapped at the exact same
time, will be taken of you. One photograph will be from the front and one from the right side.
The photographs will later be used in a software that helps to estimate 3D volumes and body
properties. Next, the researcher will do a second count down and ask you to stand as still as
possible for approximately 30 seconds. The researcher will walk around you while holding the
Kinect camera. The device will capture your position on the computer and display a cloud of
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points that represent your body as a 3D color image. This full process will be repeated three
times to ensure that there are no gaps in the data collection or gaps in the 3D reconstruction.

The data acquired from this experiment will be used to understand and evaluate the feasibility of
using a Kinect in estimating physical body parameters. If at any point you the subject are
uncomfortable with the researcher coming in contact with you even after the full procedure has
been briefed to you and the strategies identified in the “Risks” section below are implemented,
you will be withdrawn from the study.

Risks: The only known risk you may face in this study is shyness or embarrassment when
anatomical landmarks are determined by the researcher. For example, when the researcher must
identity landmarks such as the hip bones or greater trochanter of your thigh they will notify you
that that area will be identified. To reduce any discomfort the procedure will be very verbally
announced as the researcher goes through the process of placing anatomical landmarks on you.
To further help with any discomfort the researcher will point to the landmark being identified
and verbally ask each time before proceeding to place a marker there.

Benefits: While you may not benefit directly from this study, results from this study may
improve our understanding of the feasibility of using the Kinect for collecting physical body
parameters.

In/Exclusions: Female and male adults (18-30y) are the target audience for this study. If you are
pregnant you do not qualify to be in the study.

Confidentiality: All information obtained during the course of this study is strictly confidential
and your anonymity will be protected at all times. You will be identified by a study code
so that the data collected will be not be associated with your name. Data will be stored in
locked folders accessible only by the researchers listed above. Any photos or images that
may be collected will also be stored in protected folders and/or locked cabinets, located
in a locked office and locked computer. You will not be identified in any publication or
reports.

Payment: Every participant will receive $10 after completing their participation in this study as
well as a complementary 3D scan. Your participation is voluntary and you are free to
withdraw at any time. There are no consequences for withdrawal from this study. Your
signature below indicates that you understand that your participation is voluntary and that
you are free to withdraw at any time. If at any time you choose to withdraw all data that
was collected from you previously will be destroyed.

Dissemination of findings: Research results will be presented at a conference and/or in an open
access publication relevant to the digital library community. The results of this study will
be used to assess the repeatability and feasibility in estimating morphological parameters
using a Kinect. There are no foreseeable secondary uses of the data.
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Any questions about study participation may be directed to Pawel Kudzia at
pawel.kudzia@queensu.ca or Professor Geneviéve Dumas at Dumas@me.queensu.ca or at 613-
533-2648. Any ethical concerns about the study may be directed to the Chair of the General
Research Ethics Board at chair. GREB@queensu.ca or 613-533-6081.

This study has been granted clearance according to the recommended principles of Canadian
ethics guidelines, and Queen's policies.

Your signature below indicates that you have read this Letter of Information and have had any
questions answered to your satisfaction. Please keep a copy of this letter for your records.

“I understand what is being asked of me when participating in this study. I understand that
participation in this study is voluntary in nature and that I am free to withdraw at any time. I also
understand that every measure will be taken to ensure that my confidentiality is protected.
Lastly, I understand that should I have any concerns, questions, or comments regarding my
participation in this study, I will contact the researchers (Professor Genevieve Dumas) or the
Chair of the General Research Ethics Board.”

Name:

Date:

Signature:

132



A.3 Subject Data Sheet

Date and Time:

Private and Confidential: Biomechanics Research Lab

Queen’s University, Mechanical and Materials Engineering, Kingston, ON

Subject Name:

Age(y):

Weight (lbs):

Identification Code:

Height (cm)

Step 1: Experimental Set up

Step 2: Subject

Kinect connected and working

Step 3: Data Acquisition

Cameras set up

Subject Briefed

Direct subject to platform for
3D scanning protocol

Software ready

Consent Form signed

Advise to take shallow breaths

Anatomical Markers ready

Tight clothing put on

ECM set-up correct

Age, Weight, Height

Scan subject until 3 scans have
been complete (check list)

Consent Form ready

Anatomical markers (right side)

Check scans before saving

Folder made for subject

Anatomical tape

Direct Subject to location of
Jensen’s protocol

Acquire Photographs

Check Photographs

Final Checklist:

Subject Morphological [
Information

Frontal and Sagittal Plane O
photographs acquired

Scan1

3D body scans with no visible
surface error and markers visible

Scan 2

Scan 3

O
a
O
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Appendix B

Project Code

Project code is located in an own Cloud File share under the following URL:

https://myfiles.engineering.queensu.ca/public.php?service=files&t=a1b33542acc193d243edc56af12e067a

Password: Kinect

Sample data is provided as well as explicit instructions one how to execute the file. This is
included in the read me file.

Appendix C

Measuring Cylinder

mr2h

Equation A-1: Volume of cylinder where r is the radius and h is the height

VOlurnecylinder =

!

1

Emh2+zmr2 0 0
1 1
2, -2
—12mh +4mr 0
0 0 -
i 2mr |

Equation A-2: MOI along a principal axis of a cylinder with radius r and height h.

The mass was calculated based on a cylindrical density of 0.001kg/cm’
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Table A-27: Measured cylindrical values

Parameter Measurement

Radius 4.1cm#0.1cm

Height 94 0cm £0.1cm
Volume 4964 2cm’+242.0 cm’

Side View [sometric View Top View
Z
Z
X
&. X Y X ﬁ

>

<

Figure 53: Scanned cylinder showing side, isometric and top view. Coordinate system shown.
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Appendix D

Regression Equations
The equations below are in the form of Y = By + B;X; + B, X, where X; is the body weight

in kilograms and X, is the height in centimeters. The data is taken from (Zatsiorsky 2002). The
axes definitions are shown in 3.3.7 Coordinate Systems.

Table E- 1: Female MOI regression equations with output units (kgcm?®)

Longitudinal axis Mediolateral axis Anteroposterior axis

B0 B1 B2 B0 B1 B2 B0 B1 B2

Head | 3548 | 243| 0.237 664 | -0447 | 1.29 217.8 | -0.032 | 0.059

UpperTorso | 28737 | 258 12.8 2075 15.6 94| -4038.5 28.6 20

Abdomen | 6709 | 147| 753 546 | 287| 51| -368.7| -622| 8.6

Pelvis | 7159 | 235 -1.106 -633 10.8| 2.26| -987.6 149 | 3.76

Thigh | 13398 63| -828| -2659.4| 50.35| 6.96| -4033.4| 44.99 | 17.08

Shank | 53710284 | 0489 | -943.3| -251| 847| -963.1| -3.57| 9.04

Foot 23.910.337 | -0.059 -61.4 | 0.348 | 0.406 -92.24 | 0.486 | 0.558

Arm | 1186 1.19 044 | -3304 | -0461 | 2.67 -151.4 | 0.107 | 1.554

Forearm 741 0.21 -0.08 -138.5 | 0.533 | 0.887 -132.1 0.62 | 0.825

Hand | 2138 | 0.053 | 0.0073 -5.79 | 0.087 | 0.034 -5.71 | 0.122 ] 0.035

Table E- 2: Male MOI regression equations with output units (kgcm?)

Longitudinal axis Mediolateral axis Anteroposterior axis

B0 B1 B2 B0 B1 B2 B0 B1 B2

Head | 61.6 1.72 1 0.0814 | -112 1.43 1.73 -78 1.171 | 1.519

UpperTorso | 561 36.03 | -9.98 367 183 | -5.73 81.2 | 36.73 | -5.97

Abdomen | 1501 | 43.14 | -19.8 263 26.7 -8 6185 | 39.8 | -12.87

Pelvis | 775 14.7 1.685 -934 11.8 | 3.44 | -1568 12 7.741

RightThigh | _135 11.3 -2.28 | -3690 | 32.02 | 19.24 | -3557 | 31.7 | 18.61

RightShank | _70.5 | 1.134 0.3 -1152 | 4.594 | 6.815 | -1105 | 4.59 6.63

RightFoot | 1548 | 0.0144 | 0.088 | -97.09 | 0.414 | 0.614 | -100 | 0.48 | 0.626

RightArm | 169 | 0.662 | 0.0435 | -232 1.525 | 1.343 | -250.7 | 1.56 | 1.512

RightForearm | 566 | 0.306 | -0.088 | -67.9 | 0.855 | 0.376 -64 0.95 0.34

RightHand | -6.26 | 0.0762 | 0.0347 | -13.68 | 0.088 | 0.092 | -19.5 | 0.17 | 0.116
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Appendix E

Least squares plots
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Figure 54: Ordinary least squares plots comparing the Jensen (ECM) against the Kinect volume
estimates. Top: Males (n=10). Bottom: Females (n=11).
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Appendix F
ECM Qutputs

Sample ECM digitization and output data
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Figure 55: Left Side: Manual Digitization of subject in the Slicer software. Right Side: ECM

output diagram showing COM, segment endpoints and slicing.
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Kinect: Examples of Subject Sway

Figure 56: Two scans showing 3D scans which have evidence of the subject swaying or moving
during the scan. The hands and the head are most noticeable in distortion
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Kinect Differences
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Figure 57: Plot showing subjects mass(kg) against the differences between the scale and Kinect
mass estimates for males (blue) and females (orange).
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Figure 58: Plot showing subject height (m) against the differences between the scale and Kinect
estimates for males (blue) and females (orange).
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Appendix G

Kinect Data

Body Segment Volume

Females

Table G-3: Raw Body Segment volume values of 11 female participants as determined using

Kinect. A total of 16 segments are shown.

Female (n =11) VOLUME ESTIMATES [cm3]
Subjects

Seg | F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11
= H 5996 5134 4561 4890 5602 4899 4885 4730 5608 4692 4977
r:z T1 | 14725 | 19044 | 13182 | 15399 | 16254 | 13351 | 11333 | 14064 | 19426 | 11586 | 15011
Lo
é T2 8602 9373 5858 6605 7462 6903 6079 5851 6539 5192 5752
= T3 8991 11087 7597 8004 8009 7514 6794 7492 11772 7200 8124

A | 2345 | 1802 | 1742 | 2019 | 2000 | 1911 | 1773 | 1634 | 2205 | 1521 | 1588
2 [ F | 748 730 604 894 | 1465 | 727 828 764 922 859 808
A [ H | 343 377 414 383 515 398 443 414 395 348 404
< T 14577 | 12456 | 10677 | 11856 | 13550 | 12398 | 10790 | 12673 | 12827 | 9669 10259
& S 3641 3665 3408 3733 4397 3810 2577 4259 4024 3510 3060

F 820 780 731 676 959 867 834 1142 1356 924 818

A 2364 1736 1617 1723 1794 1904 1802 1729 2171 1553 1566
3 F 1078 746 470 815 881 789 868 836 894 909 801
n H 725 382 100 387 289 402 439 354 269 389 408
s T 13974 | 13095 | 10199 | 11613 | 12771 | 12690 | 10650 | 12719 | 11934 | 10121 9569
- S 3575 3780 3284 3149 3823 4014 2715 4795 4020 3736 3041

F 692 729 724 619 910 983 907 930 1361 936 604

<
L
D
wn
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Table G-4: Raw Body Segment Volume values of 10 male participants as determined using
Kinect. A total of 16 segments are shown.

Male (n =10) VOLUME ESTIMATES [ kgcm®]

Subjects
Seg M1 M2 M3 M4 M5 M6 M7 M8 M9 M10
= H 4779 5198 4836 5520 5547 5531 6010 5049 5384 5501
CE T1 | 13398 | 13482 | 14603 | 14886 | 13311 | 13002 | 16240 | 13339 | 16316 | 13594
é T2 | 12734 | 11735 | 13926 | 10205 | 8474 10508 | 10886 | 10567 | 10993 | 8056
= T3 8369 9233 9547 8258 8888 8184 8540 9480 9421 7670
A 2095 1939 2658 2001 1952 2071 2251 1787 2195 2068
2 F 1009 1004 1260 992 910 1175 1309 931 956 820
;V:J H 468 393 756 477 426 563 607 447 476 272
E" T 10318 | 11288 | 11761 8825 9904 11380 | 11478 | 9961 10569 | 9003
R S 2995 3408 3537 2697 3787 4034 3228 3406 2952 2724
F 796 1009 871 911 1215 1486 997 901 824 910
A 2005 2056 | 2264 1956 1931 1897 2124 1821 2101 2360
2 F 1158 975 986 1054 847 989 1021 939 1031 1002
7 H 460 320 525 467 353 251 287 371 559 450
5 T 9972 | 10153 | 11529 | 8975 9782 | 10862 | 11235 | 9815 | 11459 | 9125
= S 2851 3321 3189 2745 4033 3925 3310 3383 3111 2880
F 778 1032 854 959 1318 1289 1029 1058 983 870
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Body Segment Moments of Inertia

Females
Table G-5 : Raw Body Segment Data for MOI about the inertial anteroposterior axis (Ixx) of 11

Females subjects determined using Kinect.

Female (n =11) MOI Ixx [ kgcmz]
Subjects

Seg | F1 F2 F3 F4 F5 Fé F7 F8 F9 F10 F11

2z H 300 275 371 292 306 321 347 336 383 471 416
=§ T1 | 2106 | 1326 | 3149 | 1936 | 1219 | 1602 | 2038 | 1925 | 2928 | 1791 | 2399
é T2 | 409 379 582 527 510 604 623 634 1089 861 637
= T3 | 626 529 1137 582 489 600 733 689 1193 793 690
A 131 122 180 143 114 141 144 125 137 200 148

2 F 41 52 54 48 39 39 45 34 42 58 44

s | H 8 6 5 6 8 7 7 5 6 20 4
o T 1855 | 1688 | 2855 | 2491 | 1752 | 2356 | 2311 | 1964 | 2541 | 2901 | 2704
& S 321 367 574 490 217 444 413 422 401 385 505
F 30 42 79 57 32 38 40 20 30 30 44

A 137 134 213 149 107 150 154 139 139 230 141

2 F 50 51 60 46 33 34 49 42 36 44 98

7 H 6 5 9 8 9 7 7 6 7 7 9
5 T 1670 | 1711 | 2643 | 2525 | 1685 | 2400 | 2248 | 1862 | 2620 | 2825 | 2541
— S 325 403 544 573 245 467 415 325 440 366 463
F 20 40 81 41 36 46 36 16 22 21 34

Table G-6 : Raw Body Segment Data for MOI about the inertial mediolateral axis (Iyy) of 11

Females subjects determined using Kinect.

Female (n =11) MOI lyy [ kgcm?]

Subjects

Seg | F1 F2 F3 F4 F5 Fé6 F7 F8 F9 F10 F11
z H 254 236 288 250 255 274 356 249 303 388 311
ﬁE T1 | 1492 991 1555 | 1378 989 1307 | 1660 | 1658 | 2246 | 1554 | 2279
é T2 | 355 314 493 448 416 482 523 455 806 699 435
= T3 | 553 466 635 493 427 506 590 588 997 689 1043

A 133 130 146 143 101 142 132 131 130 218 201
2 F 49 49 48 45 32 33 96 41 36 42 58
i{:) H 5 4 6 7 8 6 8 5 6 6 8
) T | 1767 | 1609 | 2192 | 2379 | 1652 | 2232 | 2545 | 1852 | 2443 | 2731 | 2708
= S 318 361 405 480 215 436 482 416 399 383 565

F 29 39 38 54 30 36 41 19 28 29 75
= A 128 117 137 137 108 131 139 119 130 187 169
= F 40 50 44 47 38 38 42 33 41 56 52
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H 6 6 7 6 7 6 4 5 5 17 4
T | 1614 | 1629 | 2149 | 2432 | 1588 | 2309 | 2443 | 1764 | 2479 | 2709 | 2521
S | 323 | 399 | 410 | 567 | 243 | 454 | 458 | 322 | 435 | 360 | 537
F | 20 37 34 38 34 42 33 15 21 20 76
Table G-7: Raw Body Segment Data for MOI about the inertial longitudinal axis (Izz) of 11
Females subjects determined using Kinect.
Female (n =11) MOI Izz [ kgcmz]
Subjects
Seg | F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11
z H 188 164 195 165 178 175 210 198 193 250 226
% T1 | 1366 850 1342 | 1179 789 1027 | 1582 | 1332 | 1939 | 1226 | 2132
é T2 233 193 325 212 246 325 379 321 568 465 310
= T3 519 425 568 472 397 467 483 483 831 622 981
A 16 15 25 18 24 27 27 30 26 35 32
g F 4 5 6 4 5 4 13 6 4 5 6
s | H 3 2 2 2 3 2 3 2 2 2 2
_'g,, T 392 356 551 566 473 566 676 568 584 752 579
~ S 47 61 66 84 37 69 96 65 63 65 71
F 7 9 8 11 7 7 9 5 6 6 14
A 15 16 24 19 24 26 22 21 22 39 31
< F 5 6 5 5 6 5 6 5 4 8 6
7 H 2 2 2 2 3 2 1 2 2 6 1
5 T 346 391 535 583 463 610 598 539 634 677 506
— S 47 67 65 103 40 76 69 49 65 65 70
F 4 9 8 8 7 9 8 4 6 5 16
Males

Table G-8: Raw Body Segment Data for MOI about the inertial anteroposterior axis (Ixx) of 10
males subjects determined using Kinect.

Male (n =10) MOI Ixx [ kgcmz]
Subjects
Seg M1 M2 M3 M4 M5 Meé M7 M8 M9 M10
z H 263 300 260 313 299 345 388 262 308 326
':E T1 1754 1552 1944 1927 1804 1674 2459 1614 2130 1685
é T2 1363 1148 1498 904 729 1006 1023 899 1032 611
= T3 531 660 683 477 654 548 562 675 665 468
© A 138 149 237 170 167 191 164 143 150 183
5 F 54 53 64 61 49 74 75 50 52 42
= H 8 7 23 10 8 10 13 8 9 4
éﬂ T 1793 2063 2066 1510 1552 2343 1984 1622 1743 1507
S 358 405 466 296 478 550 371 399 335 353
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F 6 12 11 10 17 23 12 9 8 10

A 130 182 218 165 155 160 158 129 140 215
< F 66 59 57 65 46 59 60 54 49 54
7 H 9 4 13 9 5 3 3 7 12 10
5 T 1686 1664 2134 1504 1397 1996 1810 1531 1823 1508
— S 334 404 447 312 543 611 427 405 336 382

F 6 12 12 11 20 18 12 12 11 9

Table G-9: Raw Body Segment Data for MOI about the inertial mediolateral axis (Iyy) of 10
males subjects determined using Kinect.

Male (n =10) MOI Iyy [ kgcm?]
Subjects
Seg | M1 M2 M3 M4 M5 M6 M7 M8 M9 M10

z H 325 349 302 368 361 391 449 311 343 377
=§ T1 | 866 | 993 | 1035 | 1191 | 1003 | 958 | 1348 | 993 | 1365 | 1032
%]
e T2 1007 855 1097 675 469 731 691 709 715 429
= T3 629 694 763 575 592 573 629 739 758 526

A 118 145 231 167 160 189 144 138 136 176
g F 52 53 66 60 49 73 73 50 50 41
il:) H 6 6 21 9 7 9 11 7 8 3
_'g,, T 1860 2125 2179 1611 1602 2417 2095 1731 1830 1566
& S 358 410 469 297 480 556 373 404 340 351

F 29 45 35 37 60 78 42 36 34 41

A 117 173 202 162 146 159 145 122 132 191
< F 64 58 55 63 45 57 56 52 47 52
5 H 7 3 11 8 5 2 2 6 10 9
€| 1T | 1720 | 1734 | 2225 1572 | 1446 | 2076 | 1907 | 1625 1930 | 1588
= S 330 409 442 307 542 610 425 407 338 383

F 24 46 27 34 67 54 40 45 39 37

Table G-10: Raw Body Segment Data for MOI about the inertial longitudinal axis (Izz) of 10
males subjects determined using Kinect.

Male (n =10) MOI Izz | kgcmz]
Subjects

Seg M1 M2 M3 M4 M5 Mo M7 M8 M9 M10

z H 171 193 175 219 229 210 240 191 205 213
% T1 1673 1535 1935 1664 1404 1409 2022 1402 2027 1391
é T2 1203 1129 1530 888 668 870 1051 1009 1125 663
= | T3 710 791 872 659 682 650 748 833 865 611
A 47 29 41 27 27 32 46 23 43 32

:én ¢ F 9 8 14 7 6 9 12 7 8 5

24 H 4 3 7 3 3 5 6 3 3 1
T 423 507 536 325 402 487 535 409 461 342
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S 47 65 61 40 70 79 54 62 45 39
F 29 45 34 38 54 70 40 36 36 37
A 38 32 39 28 32 32 34 27 33 57
< F 10 8 8 13 5 7 8 7 9 8
»n | H 3 2 5 3 2 1 2 2 4 3
S| T 395 421 493 327 389 423 523 398 541 342
=1 46 57 48 44 78 68 56 59 50 38
F 24 41 26 35 59 57 39 46 36 33

Raw ECM Data

Body Segment Volume

Females

Table G-11: Raw Body Segment Volume values of 11 Females participants as determined using

ECM.
Female (n =11) VOLUME ESTIMATES [ cm?]
Subjects
Seg | F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11
iy H 6183 5482 4782 4995 5380 4809 4587 4312 5295 4491 4851
S
E T1 | 13695 | 17232 | 12343 | 12866 | 13828 | 11107 | 9247 11427 | 16356 | 9902 11941
5
& T2 7755 7429 5862 6532 7508 6518 5852 5649 6163 5149 5720
= T3 8935 10841 | 7529 7916 7789 7493 6769 7086 | 11653 | 7193 8135
A 2382 1767 1814 1877 2031 1926 1841 1767 2295 1536 1580
§ F 1036 820 693 873 1047 974 872 786 1106 726 851
e H 486 334 407 543 451 337 533 431 557 305 456
< T 14667 | 12202 | 9625 11050 | 11373 | 11556 | 10899 | 11360 | 11799 | 9174 9964
& S 3552 3377 3355 3778 4171 3383 2709 4164 4027 3328 3153
F 1035 795 783 750 887 712 882 939 1121 914 1111
Males
Table G-12: Raw Body Segment Volume values of 11 Females participants as determined using
ECM.
Male (n =10) VOLUME ESTIMATES [ cm?]
Subjects
Seg M1 M2 M3 M4 MS Me M7 M8 M9 M10
é . H 4779 5384 4916 5231 5644 5627 5601 4928 5284 5498
P T1 11857 13022 13207 12650 11374 12077 12512 10738 14040 11506
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T2 10965 11606 13903 10061 8053 10379 9909 10313 10351 8117
T3 8392 8845 9359 8281 8890 8124 8540 9527 9445 7658
A 2062 1979 2776 2086 1989 2153 2254 1833 2210 2133
3 F 1186 1163 1198 1239 869 1232 1405 926 1118 983
§ H 708 706 659 640 551 697 683 485 567 504
Eﬂ T 10757 10068 10383 8563 9522 11119 11314 9085 10498 9148
a S 2905 3205 3582 2871 3787 4264 3366 3448 3049 2993
F 896 943 849 936 867 1317 1090 1081 923 927

Body Segments Moments of Inertia

Females

Table G-13: Raw Body Segment Data for MOI about the inertial anteroposterior axis (Ixx) of 11
Females subjects determined using ECM.

Female (n =11) MOI Ixx [ kgcmz]
Subjects

Seg | F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11
z | H 0 0 0 0 0 0 0 0 0 0 0
=§ T1 1393 | 2235 1220 1306 1561 988 798 1198 | 2087 890 1228
é T2 591 589 378 459 546 429 381 391 393 311 353
= | 13 616 1126 471 525 486 563 414 459 1178 566 651

A 180 126 133 117 170 127 112 158 217 131 131
2 F 51 45 30 46 57 49 38 48 77 43 49
25 H 13 6 8 13 12 9 12 10 16 7 12
_'En T 2914 | 2536 1411 1719 | 2211 2187 1715 2204 | 2505 1576 1970
& S 422 428 380 449 574 453 243 607 654 418 393

F 44 34 31 27 43 33 36 44 61 41 58

Table G-14: Raw Body Segment Data for MOI about the inertial mediolateral axis (Iyy) of 11
Females subjects determined using ECM.

2
Female (n =11) MOl Iyy [kgcem”]

Subjects
Seg | F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11
. LH 0 0 0 0 0 0 0 0 0 0 0
Et;: T1 | 1003 | 1514 962 954 1081 739 547 825 1559 659 908
= 396 397 242 302 376 305 236 210 294 193 236

147




T3 803 915 617 632 630 501 489 511 996 466 561

A 189 21 138 126 175 24 117 162 231 133 135
2 F 50 44 30 44 55 8 37 47 75 42 48
% H 11 5 7 11 10 2 11 8 14 6 10
5 T 3029 571 1506 | 1857 | 2336 | 2342 | 1865 | 2339 | 2645 | 1673 | 2071
A S 426 431 387 462 584 459 245 617 659 432 398

F 42 33 30 27 42 33 35 42 59 39 59

Table G-15: Raw Body Segment Data for MOI about the inertial longitudinal axis (Izz) of 11
Females subjects determined using ECM.

Female (n =11) MOI Izz [ kgcmz]
Subjects

Seg | F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11
Z H 0 0 0 0 0 0 0 0 0 0 0
GE T1 1205 1756 886 1061 1159 809 617 815 1409 625 825
%]
D& T2 749 833 444 606 632 557 464 450 553 375 423

T3 693 851 499 529 540 478 396 440 967 419 508

A 35 130 20 25 24 132 23 18 31 14 15
g |F 9 6 4 6 9 46 7 5 9 4 6
s | m | 4 2 3 4 3 8 4 3 4 2 3
_'En T 790 2678 416 524 508 537 515 499 521 341 378
~ S 67 57 58 73 83 56 43 80 72 57 50

F 10 6 6 6 7 5 7 8 11 8 10
Males

Table G-16: Raw Body Segment Data for MOI about the inertial anteroposterior axis (Ixx) of 10
males subjects determined using ECM.

Male (n =10) MOI Ixx [ kgcmz]
Subjects

Seg M1 M2 M3 M4 M5 M6 M7 M8 M9 M10

z | H 0 0 0 0 0 0 0 0 0 0
ﬂE T1 1180 1347 1418 1286 1103 1164 1303 963 1542 1068
é T2 1118 1039 1600 929 671 1000 919 851 916 580
= | T3 543 611 703 655 755 544 692 820 691 484
A 163 171 276 186 178 225 211 158 186 217

2 F 75 74 77 82 49 77 86 60 61 64

i':) H 20 21 20 17 12 20 18 11 15 12
Eﬂ T 1956 1857 2043 1404 1674 2433 2059 1582 1912 1742
~ S 355 419 543 382 541 614 444 442 381 422

F 43 43 43 47 42 70 55 55 48 47
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Table G-17: Raw Body Segment Data for MOI about the inertial mediolateral axis (Iyy) of 10
males subjects determined using ECM.

Male (n =10) MOI Iyy [ kgcm?]
Subjects
Seg | Ml M2 M3 M4 M5 M6 M7 M8 M9 M10
z | H 0 0 0 0 0 0 0 0 0 0
=§ T1 | 73] 936 880 897 740 754 854 639 1025 792
%
= | T2 | 75 821 1091 642 436 700 608 685 651 445
= 13| 711 753 802 571 633 631 602 731 853 516
A 169 176 288 193 185 235 220 165 199 225
g | F 73 70 74 80 47 74 82 58 58 63
# | H 17 17 17 15 10 16 16 9 12 10
S| T | 2014 1952 | 2151 1514 1734 | 2526 | 2176 1668 | 2024 1830
| S 360 429 548 389 551 634 452 448 388 428
F 41 43 41 45 40 69 56 52 46 46

Table G-18: Raw Body Segment Data for MOI about the inertial longitudinal axis (Izz) of 10
males subjects determined using ECM.

Male (n =10) MOI Izz [ kgcm?)
Subjects
Seg | Ml M2 M3 M4 M5 M6 M7 MS M9 M10
z | H 0 0 0 0 0 0 0 0 0 0
=§ T1 | 1041 1083 1232 1031 854 1080 1058 856 1297 864
%
2| T2 947 1243 1469 867 590 857 858 990 1057 717
= | 13 619 652 714 558 605 562 593 703 734 566
A 26 23 41 25 23 25 29 20 31 25
g | F 11 10 11 11 6 12 15 6 10 7
s | H 7 7 6 6 5 7 6 4 5 4
S| T 447 415 421 315 366 442 502 339 446 331
| S 46 53 58 41 67 87 57 59 49 45
F 7 8 6 7 7 14 10 10 7 7
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